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Information in this document is subject to change without notice.  No part of this document may be 
reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, 
without the express written permission of Datavideo. 

© Datavideo.  All rights reserved.  All Datavideo products are trademarks or registered trademarks of 
Datavideo.  Other brand and product names are trademarks or registered trademarks of their 
respective holders. 

Limited Warranty 
Datavideo warrants for a period of three (3) months after the date of delivery to you, (the “Warranty 
Period”), the following:  (a) that the Software will perform in substantial compliance with the 
“Instruction Manual”, provided that it is used on the computer and with the hardware for which it was 
designed; (b) that the magnetic media on which the software is distributed is substantially free from 
significant defects in materials and workmanship; and (c) that the “USB Hardware Key” is substantially 
free from significant defects in materials and workmanship. 

In the event of a breach of this warranty, Datavideo sole obligation is to replace or repair, at 
Datavideo option, any Product or component thereof, free of change.  Warranty claims must be made 
in writing during the Warranty Period, accompanied by evidence satisfactory to Datavideo.  All 
Products should be returned to the distributor from which they were purchased (if not purchased 
directly from Datavideo) and shall be shipped by the returning party with freight and insurance paid. 

This warranty does not cover abuse, shipping damage, neglect, tampering by unauthorized 
personnel, damage inadvertently caused by the user, or any system or part thereof whose serial 
number has been removed or defaced. 

EXCEPT AS STATED ABOVE, THERE IS NO OTHER WARRANTY, EXPRESSED OR IMPLIED, 
REGARDING THE PRODUCT INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 

Datavideo Technologies Co., Ltd.   
10F, 176 Jian-Yi Rd,  
Chung Ho City,  
Taipei Hsien,  
Taiwan 235 
Tel: +886 2 8227 2888   
info@datavideo.com.tw        
www.datavideo.com.tw 
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Installation 
This Chapter explains how to install the Software and the USB Hardware Key (dongle) for the 
Software.  It also describes the type of system that you will need before you can run the program. 

System Requirements 
Operating system: 
CG-350 is designed to run under Windows 98 (SE), Windows ME, Windows 2000 or Windows XP.  
You need one of these operating systems (or later versions) on your computer in order to run the 
program. 

Processor (CPU): 
The program will run only on a 1 Ghz Pentium (or higher) processor. 

RAM: 
CG-350 will run with as little as 128 Mbytes of system RAM.  However it will run very slowly.  It is 
recommended that you have at least 512 Mbytes of RAM. 

Hard Disk Space: 
You must have a minimum of 80 Mbytes of Hard Disk space to install the program.  If you intend to 
create many Background Graphics, or save a lot of pages as graphic images (i.e. BMP, TGA, etc), 
make sure that you have enough Hard Disk space available.  Saving pages in the Datavideo Page 
(PAG) format doesn’t require large amounts of disk space (approx. 2-4 Kbytes per page) unless logos 
or textures are added to the pages 

CD-ROM:
If you intend to install the software from a CD-ROM, the system must have a CD-ROM drive. 

VGA Card: 
The VGA Card must be set to either 16 bits per pixel (High Colour), 24 bits per pixel (True Colour), or 
32 bits per pixel (Alpha) mode.  If you run your VGA card in High Colour mode, the colour spreads 
may not appear smooth on your VGA monitor.  This will not affect the quality of the Title Graphics that 
are produced.  They should appear very smooth in 24 or 32 bits per pixel mode.  The Program will not 
run if the VGA mode is set to 8 (or less) bits per pixel. 

USB Port: 
The computer must have at least 1 unused USB port to install the USB Hardware Key (Dongle). 

PCI / PCI express card slot: 
The Computer must have a free PCI / PCI express card slot available for your choice of optional 
display card whether this will be an AJA Xena or Blackmagic Design DeckLink card. 
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Installing your AJA or Blackmagic Design display card 
Please follow the display cards own installation instructions for fitting the card and installing any 
associated drivers before proceeding with the CG-350 software installation. 

Packing List 
CG-350 Instruction Manual  x1 
CG-350 Installation CD-ROM  x1 
CG-350 USB Hardware Key  x1 

Installing the Software 
The Program has a Setup program to help you setup the software to run on your computer.  The files 
on the install CD are compressed.  The only way to make sure that the files are correctly installed is to 
use the Setup program. 

Installing from the CD 
Insert the Datavideo Software Installation CD into the CD-ROM drive.  If the Install window does not 
automatically appear after a few seconds, browse the CD and run the “SETUP.EXE” program.   

Follow the on screen instructions until the software is completely installed.  When the software is 
installed, the computer will restart.  After the computer is restarted the USB Hardware Key (dongle) 
can then be installed. 

A folder called “PowerCG_Live” should now be in the Programs menu.  There will also be an Icon 
called CG-350 on your desktop. 

Installing the USB Hardware Key 
Once the software is installed and the computer has restarted, the USB Hardware Key (dongle) can 
be inserted into one of your computer’s unused USB ports.  A “Found New Hardware” window will 
appear the first time that the dongle is inserted.  Follow the on screen prompts. Once complete, the 
program is ready to run. 

Checking the Installation 
Run the program to test the installation by opening the CG-350 folder and double clicking on the CG-
350 icon, or by double clicking on the CG-350 Icon on the Desktop.  The program’s windows should 
appear after a few seconds. 
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CG-350 Overview 
CG-350 is used to create and display title pages.  The program is divided into two sections.  These 
are Page Creation and Page Display. 

The CG-350 program allows you to create a list of pages and then display those pages either 
automatically or under manual control.  Under manual control each page that you have created can 
be displayed with its assigned page transition.  Each page is displayed when you want it, for as long 
as you want it.  The pages are previewed so there is no question as to which page will be displayed 
next.  The pages are displayed when you press the appropriate button/key.   

A list of pages can also be setup to automatically sequence.  Each page will be displayed with the 
Page Transition Type, Transition Speed, and Dwell Duration that the user selected for the page.  The 
Pages will continue to automatically sequence until you stop it.  This feature is very useful for creating 
Kiosks and Message Information Channels. 

The title pages can contain text, background colour boxes, geometric shapes, full-colour graphic 
images as logos, and either a background graphic or background video.  The text can be created 
using TrueType typefaces and can be sized, rotated, and italicized.  Each character can have up to 
two edges and three shadows.  The character’s edges and shadows can be set with a solid colour, a 
vertical colour spread, a colour gradient (4pt, 5pt, or linear), or with a texture. 

Background colour boxes can be created any size and position on the screen.  They can be set with 
all of the same colour options as characters; they can even be made semi-transparent. 

Geometric shapes can be created at any size and position on the screen.  The roundness of the 
shape can be controlled and the shape can be made square, completely round (as a circle or ellipse), 
or anywhere in between.  Shapes can be sized, rotated, italicized, edged, and set just like a 
character. 

Standard graphic format graphics can be loaded as either full-colour logos or as a background image.  
When they are loaded as logos, they can be sized and positioned anywhere on the screen. 
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CG-350 User Interface 
If you don't have the software installed yet, please follow the installation directions first. 

Start the program as you would any other program under Windows.  After a few seconds the 
program's User Interface will appear.  The first time that you run the program you will be asked to 
select which Video Format to use (NTSC, PAL, etc).  The software will automatically adjust its user 
interface to fit your screen.  If your computer screen resolution is set to 1024 by 768, it will appear 
similar to below. 

Screen appearance at 1024 by 768 resolution 

This User Interface is divided into 7 sections.  These sections are Menu Bar, Toolbar, Preview 
Window, Display List Editor, Control Buttons, Media Catalog, and Status Bar. 
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Menu Bar 

Menu Bar 

The menu (shown above) is just what you expect in a Windows program.  It has a "File" menu that is 
used to open, create, and save Display Lists.  It has an "Edit" menu used for the normal Undo, Cut, 
Copy, Paste, Insert, Delete, and Edit functions.  There is a "View" menu that is used to control how 
the User Interface appears on the screen.  The "Display" menu has selections to control which page is 
displayed on the output monitor.  The "Catalog" menu is used to select what appears in the Media 
Catalog section.  "Settings" menu is for setting Video Format, and User Preferences.  The "Help" 
menu is used to call up the Help text. 

Tool Bar 

Toolbar 

The Toolbar (shown above) is a quick way to access common functions.  These include commands 
from the File menu such as Create, Open, and Save Display Lists.  The cut, copy, paste, and undo 
functions from the Edit menu are also included on the toolbar. 

Preview Window 

Preview Window 

The Preview Window (shown above) displays the next page that will appear on the video output.  This 
gives you a confidence check so that you will know whether or not you are about to display the wrong 
page.  The size of this window can be controlled from the "View" Menu. 
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Display List Editor 

Display List Editor 

The Display List Editor (shown above) is used to create and edit Display Lists.  You can Add, Delete, 
and Duplicate images here.  You can also change the order of the images in this window using "drag 
and drop".  This will change the order that the pages will be displayed.  You can also randomly select 
the next page to display for those "last minute" changes. 

Control Buttons 

The Control Buttons (shown above) are used to control the Previewed page.  
The Previewed page can be displayed ON AIR or edited using these buttons. 
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Media Catalog 

Catalog Section 

The Media Catalog (shown above) is divided into groups based upon the type of images that the 
software can display.  These are Titles, Text Animations, and Graphic Images.  These images can be 
quickly added to the Display List Editor to create a Display List. 

The Title Catalog shows the pages in the current project. 

The Text Animation Catalog shows the Text Animations that have been created and pre-rendered 
with the Title Composer. 

The Graphic Image Catalog shows the graphic images that are stored in the folders that have been 
included in the catalog.  See “Select Catalog Folders” in Chapter 3 for more information. 

Status Bar 

Status Bar 

The Status Bar has a prompt to give you a little more information about a menu or toolbar selection.   
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Quick Tutorial 
If you don't have the program running yet, start it just like you would any other Windows program. 

Before you start composing Title Pages, you will probably want to create a new project for them.  This 
keeps all of the pages of a Project together as you don’t want them getting them mixed up with pages 
from other projects.  Creating a project is much like creating a new folder in Windows. 

Since the subject of creating Title pages will be left to the "Title Composer” section of this manual, we 
will start with some example pages that have already been created.  Select "Catalogs" from the Menu 
and select the "Select Title Project" entry.  The "Select Title Project" window will appear.  Double click 
"SHOW_OFF" to select the project.  The pages that are in the "SHOW_OFF" project will appear in the 
Title Catalog at the bottom of the screen. 

Although not absolutely necessary (unless doing Auto Sequencing), you will probably want to create a 
Display List before going ON AIR.  The easiest way to do this is to double click the pages in the Title 
Catalog, in the order that you want them to appear. 

Create a new Display List by selecting the "File" menu and "New Display List" entry.  This will clear 
the Display List Editor and "Untitled" will appear above it as the name of the Display List.  Double 
Click the "Intro" page in the Title Catalog.  It then appears at the first position in the "Display List 
Editor".  If there is a Scroll Wheel on the mouse, you can scroll through the Catalog by moving the 
mouse pointer over the Catalog and then rotating the mouse Scroll Wheel.  Now double click the 
following pages in the Title Catalog in the following order: cgpower, introa, introb, intro1, intro1a, 
intro2, intro2a, intro2b, intro3, and intro3a.  Every time that you double click a page it should appear at 
the end of the Display List. 

Notice that we missed the page "Intro2c".  You can add this to the display list using one of two 
methods.  To use the first method, double click on the "Intro2c" page.  It appears at the end of the 
Display List.  To place this page between Intro2b and Intro3, move the mouse pointer over the page 
to be moved in the Display List, press and hold down the left mouse button and drag the page until it 
is on top of the "Intro3" page, then release the mouse button.  The Intro2c page is now placed in front 
of the Intro3 page, and will be displayed before it in the sequence.  To use the second method, move 
the mouse over the Intro2c page in the Title Catalog, press and hold down the left mouse button and 
drag the page until it is on top of the "Intro3" page, then release the mouse button. 

Congratulations, you just created your first Display List.  To save it, select "File" from the menu and 
select the "Save Display List" entry.  Since the Display List hasn't been named yet, the program asks 
you to enter a name.  Name it "SHOW_OFF" and press the "Save" button. 

Now it's time to go ON AIR.  Press the "Start Auto Sequence" button.  The first page in the Display 
List is displayed on the Video Output, and the next page in the Display List is shown in the Preview 
Window.  After a few seconds the next page will be displayed.  These pages are being displayed with 
the "Page Transition" that was selected when the page was created, at the selected "Display Speed".  
Each page will appear for the duration specified by the "Dwell Time" of the page. 

This sequence will continue until you press the "Stop Auto Sequence" button. 

To manually display a page on the Video Output, double click the page that you want to display.  The 
selected page will appear in the Preview Window.  Press the "Display Previewed Page" button.  This 
page is then shown on the Video Output.  To remove the page from the Video Output, press the 
"Page Off" button, and the page will be removed.  This gives you full random access to any page in 
the Display List. 

Most of the time when displaying pages, you know before hand which order that you want them to 
appear.  This is a good reason to use the Display List.  Once the Display List is loaded, preview the 
first page that you want to show.  When you are ready to go ON AIR, press the "Display Page and 
Preview Next" button.  The Previewed page is displayed on the output monitor and the next page in 
the display list will be previewed.  You can continue on through this Display List by pressing this 
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button each time you want the next page to appear.  Pressing the <Enter> key on the keyboard’s 
number Keypad will also perform this function.  This makes ON AIR operation a single key operation.   

Preview Window 
The Preview Window displays the next page that will appear on the video output.  This gives you a 
confidence check so that you will know whether or not you are about to display the correct page.  The 
size of this window can be controlled from the "View" Menu. 

When you right click in this window, the following menu will appear: 

Preview Window Menu 

Select Page For Preview: 
By selecting this entry you can select an image to be previewed.  This page does not need to be in 
the current title catalog. 

Display Previewed Page: 
Selecting this entry will display the previewed page on the Video Output using the Display Transition 
Type and Speed that was specified when the page was composed. 

Display Image and Preview Next: 
This menu entry will display the previewed page (just like "Display Previewed Page"); it will also 
preview the next page in the Display List. 

Program Off: 
This menu entry will remove the current page from the Video Output. 

Preview Window Size 
Preview Window - Small 
Preview Window - Medium 
Preview Window - Large: 

Use these menu entries to select the desired size of the Preview Window.  The size that is currently 
selected is marked with a "dot". 

Edit Previewed Page: 
This menu entry allows you to edit the previewed page.  Selecting this will start the Title Composer 
and load the previewed page into it. 
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Start Auto Sequence: 
When this menu entry is selected, the program will start Automatically Sequencing the pages in the 
Display List.  Each page will be displayed with the Page Transition Type and Transition Speed that 
the user selected for the page.  Each page will remain (or Dwell) on the Video Output screen for the 
amount of time that the user specified as the "Dwell Time" for the page. 

Display List Editor 
The Display List Editor is used to create and edit Display Lists.  You can Add, Delete, and Duplicate 
images here.  You can also change the order of the images in this window using "drag and drop".  
This will change the order that the pages are displayed. 

Left Clicking on an image in this window will select the image.  Left Clicking on a blank portion of this 
window will display a window that lets you select a Title Page to add to the Display List. 

To change the order of the pages in the Display List, position the mouse over the page that you want 
to move, press and hold down the left mouse button, move it to another position in the display list, 
then release the left mouse button.  The selected page will be moved to the position that it was 
dragged to.  If you drag the page to the Preview Window, the page will be previewed. 

You can also preview a page in the Display List by double clicking on it. 

If you right click in this window, the following menu will appear: 

Display List Editor Menu 

Preview Page: 
Select this entry to preview the selected page. 

Edit Page: 
Select this entry to edit the selected page.  This will start the Title Composer and load the selected 
page into it. 

Add Page: 
Selecting this entry will display a window that lets you select a Title Page to add to the Display List. 

Remove Page: 
Use this menu entry to remove a page from the Display List. 
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Duplicate Page: 
Use this menu entry to duplicate the page in the Display List.  Once it has been duplicated, you can 
drag it to another position in the display list.  When this is done, the page will display multiple times 
during the sequence. 

New Sequence List: 
This will clear the current Display List and create a new one. 

Open Sequence List: 
Use this entry when you want to work with a Display List other than the one that is currently loaded. 

Save Sequence List: 
When you have made changes to the Display List, selecting this Menu entry will Save the Display List 
to disk. 

Save Sequence List As: 
When you select this menu entry, you will be prompted to enter a name for the Display List.  The 
Display List will then be saved under the new name.  The original Display List file will not be changed. 

Start Auto Sequence: 
When this menu entry is selected, the program will start Automatically Sequencing the pages in the 
Display List with the Display Transition Type and Speed that was specified when the page was 
composed.  Each page will remain (Dwell) on the Video Output screen for the amount of time that was 
specified as the "Dwell Time" when the page was created. 
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Control Buttons 
The Control Buttons are used to control the Previewed page.  It consists of the 
following buttons: 

Edit Title: 
Press the button to edit the page shown in the preview window.  This will start 
the Title Composer and load the previewed page into it. For more information 
on Title composer see page 24. 

Start Auto Sequence: 
When this button is pressed, the program will start Automatically Sequencing 
the pages in the Display List with the Display Transition Type and Speed that 
was specified when the page was composed.  Each page will remain (Dwell) 
on the Video Output screen for the amount of time that was specified as the 
"Dwell Time" when the page was created. 

Page Off: 
Pressing this button will remove the page from the Video Output. 

Display Previewed Page: 
Pressing this button will display the previewed page on the Video Output using the Display Transition 
Type and Speed that was specified when the page was composed. 

Display Image and Preview Next: 
This button will display the previewed page (just like "Display Previewed Page"); it will also preview 
the next page in the Display List. 
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Image Catalogues 
The image catalogues are used to quickly select Title Pages, Animation Sequences, and Graphic 
Images.  The Catalog section has three (3) catalog tabs.  Each tab selects the catalog that contains 
each type of image.  To use title pages, select the “Title Pages” tab.  Select the “Animations Catalog” 
to use an Animation Sequence.  The “Graphics Catalog” is used to select a graphic image to be 
displayed.  Images from each catalog can be intermixed and displayed in any order. 

To add an image to the display list, select the catalog that contains the type of image that you want to 
select, place the mouse over the Picon of the image that you want to use, press the left mouse button, 
hold it down, and drag it to the desired position in the display list.  If you drag it to the Preview window 
the image will be previewed.  Double Clicking on a Picon will add the image to the last position of the 
Display List. 

When you right click on a catalog window a menu will be displayed.  This menu varies depending on 
the type of catalog.  The menu displayed for each catalog is shown below. 

Title Catalog Menu Animation Catalog Menu Graphic Catalog Menu 

These menus can be used to select images from the catalog, or to configure the catalogs. 
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Title Catalog 
The Title Catalog displays the pages in the current project.  Below is a brief description of each menu 
entry.

Preview Page: 
Select this entry to preview the selected page. 

Edit Page: 
Select this entry to edit the selected page.  This will start the Title Composer and load the selected 
page into it. For more information on Title composer see page 24. 

Add Page to Display List: 
Selecting this entry will add the selected title to the last position of the Display List. 

Select Title Project: 
This menu entry allows you to change the current Title Project.  When you select a new Title Project, 
the pages currently displayed in the Title Catalog will be replaced with the pages that are in the newly 
selected Title Project. 

Animation Catalog 
The Animation Catalog displays Text FX Animation Sequences that have been created and pre-
rendered by the Title Composer.  Below is a brief description of each menu entry. 

Preview Animation: 
Select this entry to preview the selected Animation Sequence. 

Add Animation to Display List: 
Selecting this entry will add the selected Animation Sequence to the last position of the Display List. 

Select Folder(s) for Animation Catalog: 
Selecting this entry will display the “Select Folders” window.  This window is used to select which 
folders (and subfolders) that contain the Animation Sequences that you want to appear in the 
Animation Catalog.  See the section “Select Catalog Folders” below for more information. 

Update Animation Catalog: 
Selecting this entry will update the catalog to include any Animation Sequences that have been added 
to the selected folders as well as any changes made to Animations that are already displayed in the 
catalog. 
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Graphic Catalog 
The Graphic Catalog displays the Graphics Images that are in the Directories/Folders that have been 
selected.  Below is a brief description of each menu entry. 

Preview Graphic Image: 
Select this entry to preview the selected Graphic Image. 

Add Graphic Image to Display List: 
Selecting this entry will add the selected Graphic Image to the last position of the Display List. 

Select Folder(s) for Graphic Catalog: 
Selecting this entry will display the “Select Folders” window.  This window is used to select which 
folders (and subfolders) contain the Graphic Images that will be displayed in the Graphic Catalog.  
See the section “Select Catalog Folders” below for more information. 

Update Graphic Catalog: 
Selecting this entry will update the catalog to include any Graphic Images that have been added to 
the selected folders as well as any changes made to images that are already displayed in the catalog. 

Select Catalog Folders 
To select which directories/folders that are to be included in the catalog, right click on the catalog and 
select the “Select Folder(s) for Catalog” entry from the pop up menu.  This will display the “Select 
Folders” window similar to the one shown below. 

This window is divided into 2 sections.  The left hand section is used to select which directory/folders 
to include. The right section displays the folders that are currently included in the catalog. 

The left section is composed of the following controls: 

Current Directory box 
Drive Selection drop down box 
Folder Selection List 
Add to Catalog button 
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The Current Directory box displays the folder that is currently selected.  This is the directory that will 
be added to the “Included Folders” list when the “Add to Catalog” button is pressed.  Select the drive 
which contains the folder(s) that you want to include from the Drive Selection drop down box, and the 
folders that are on the selected drive will appear in the Folder Selection List. 

When a folder is selected from the Folder Selection List, it is expanded to display all of the sub-folders 
which are in that folder.  The selected folder also appears in the Current Directory box.  Select the 
folder that you want to add to the Catalog and press the “Add to Catalog” button.  The folder will then 
appear in the included folders list in the right hand section of the window. 

The right hand section is composed of the “Included Folders” list and the “Remove From List” button.  
To remove a folder from the catalog, select it in the Included Folders list and press the “Remove From 
List” button.  The folder will be deleted from the Included Folders list. 

Once the Included Folders list displays all of the folders that contain the images that you want to 
appear in the catalog, press the “OK” button.  The Select Folders window will disappear and the 
catalog will be redrawn with the images that are in the folder(s) that you selected. 
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Title Composer 
By clicking on Edit Title in the Control Panel of CG-350 you enter the Title Composer windows. 

Screen appearance on a 1024 by 768 VGA screen. 

Menus
The menu bar (shown below) is just what you would expect in a Windows program.  It has a “File” 
drop down menu that is used to open, create, and save, the types of files that Title Composer can 
work with such as pages, templates, and projects.  It has an “Edit” menu that is used for the normal 
Undo, Cut, Copy, Paste, Insert, Delete, and Erase functions. 

Title Composer menu bar. 

The “View” menu is used to display or hide the various windows. 

The “Attributes” menu is used to adjust the various text settings. 

The “Move Text” menu has commands for Word Wrap/Unwrap, Centreing, Justifying, and Positioning.  
It also has a command to let you adjust the Row Leading. 

The “Layers” Menu is used to change the layering priority (move one in front of another). 

The “Settings” menu is used to setup your system.  These include things like Setting User 
Preferences, Loading Typefaces, Setting Tabs, Adjusting Safe title Margins, set the page to Lower 
Third mode, and setting your default folders / directories. 
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If Text FX is supported on your system, there will be a Text F/X menu.  The “Text FX” menu launches 
the Text FX editor.  This allows the system to independently animate each layer. 

The “Help” Menu is for learning more about how to use the program. 

Title Composer Toolbar 
The Toolbar (shown above) is a quick way to access common functions.  These include commands 
from the menu bar such as Create New Page, Open Existing Page, and Save page.  As well as check 
spelling; cut, copy, paste and undo functions from the Edit menu are also included on this toolbar. 

The toolbar contains a mode selection box that defaults to "Selected Text".  This determines which 
text will be affected when Character Attributes (font, size, edge, colour, etc.) are changed or when text 
is repositioned.  The options include such things as Selected text, entire word, entire row, entire layer, 
and entire page. 

To the right of the mode selection box are some buttons that Centre and Justify the current layer.  
There are even buttons to change the priority of the current layer (move one in front of another). 
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Project Manager Window 
The project manager window (Shown on the left) keeps the settings and 
pages from different projects separate from one another.  It also gives you 
quick access to all of the pages in a project.  The top of the Project 
Manager displays the name of the current project, in this case 
DVUS_demo. 

When a Page is saved, a "PICON" is created which is a miniature image of 
the page.  These PICONs, along with the name of each page in the project 
is displayed in the Project Manager window.  To open a page, just click on 
its PICON. 

Title Compose Window 
The Title Compose window is where you compose your title pages.  To 
enter text in this window, point the mouse to where you want the text to 
appear, and click the left mouse button.  A rectangle will appear where you 
clicked the mouse.  This is the text cursor.  It shows where text will be 
entered.  Type some text and it will appear as the cursor position moves 
along. 

Shortcut Buttons 
The Shortcut Buttons window contains buttons of frequently used 
functions.  They are placed in this handy position so that you can just 
reach over and easily press one of these buttons with the mouse. 

Preset Style Gallery 
Each project can have up to 64 preset text styles.  These are text styles that you may want to use 
frequently.  You're not limited to only these 64 styles, they are only there as shortcut to the styles that 
you use most often.  You can scroll through the preset text styles, and select one by clicking on it.  
When you select a new style from the Style Gallery, all selected text will be set to the new style.  You 
can change these preset text styles to be whatever you want. 

Page Template Gallery 
Many users like to have a common look to their titles.  Whether it is for their entire facility, or a unique 
"look" for each client.  With Title Composer you can create a Page Template of the desired page style 
with "Template Fields" at different positions on the page.  When the Page Template is opened, a 
window appears that prompts the user to enter the text for each field.  Once the text is entered, the 
page is automatically created using the style of the Template and the text that was entered in the 
Template Fields. 

Controls Tabs 
The Title Composer gives you a lot of control over the appearance of the characters.  So much so, 
that all of the controls required to set all of the different parameters that can be controlled, would not 
fit on your screen at one time.  So we have divided them up into groups and placed each group of 
controls on its’ own separate tabbed box.  We then took each box of controls and placed them all in a 
single window with tabs to select which group of controls that you want to use. 
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Character Tab 

The Character Tab is used to change the Height, Width, Italics angle, Rotation, Kerning, and Blur of 
the character.  It is also used to select the Typeface for the text.  Clicking and dragging the cursor 
handles can also change the text size, position, italics angle, and rotation.  You can turn the handles 
on and off.  So they only appear when you want to use them.

Any of the values represented by icons (Height, Width, Italics, Rotation, Kerning, and Blur) can be 
modified by clicking on the appropriate icon and dragging the mouse.  The text will be redrawn with 
the new values as you drag the mouse. 

Edges Tab 

Each character can have 2 edges.  You can select from the following:  

No Edge  - This edge does not appear 

Full Surround - The edge surrounds the character equally on all sides 

Extruded - The character is extruded to give the character a 3D look 

Highlighted - The character is extruded with a narrow full surround border to highlight the  
  character  

Offset  - The edge is offset as if it is casting a shadow.   

The depth and blur of each edge can be set separately.  If the selected edge type is Extruded, 
Highlighted, or Offset, the direction can be set to any of the 8 directions.   

The features for Edge 1 and 2 work identically.  However Edge 1 appears in front of Edge 2.   
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Clicking on the "Depth" icon and dragging the mouse will change the edge depth.  Clicking on the 
"Blur" icon and dragging the mouse will change the edge blur.  The text will be redrawn with the new 
values as you drag the mouse.   

Shadows Tab 

Each character can have up to 3 shadows in addition to the 2 edges.  The shape of each shadow can 
be set to be the same shape as the Character, Edge 1, or Edge 2.  All 3 sets of shadow controls work 
the same. 

Each component of the character (Character, Edges, and Shadows) stack up in the following order:  

CHARACTER  
SHADOW 1  
EDGE 1
SHADOW 2  
EDGE 2
SHADOW 3  

Shadow 1 is between the Character and Edge 1, Shadow 2 is between Edge 1 and Edge 2, and 
Shadow 3 is behind Edge 2.   

The position of each shadow can be independently varied in single pixel increments.  They can be 
offset from the character by as much as 100 pixels in any direction.  Clicking on the "Offset" icon and 
dragging the mouse will move the shadow in relationship to the character.   

The colour of each shadow can be set independently.  It can be set to any colour (including a 
Gradient or a Texture) just like the characters and edges. 
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Colours Tab 

The Colours Tab is used to change the colour of the Character, both Edges, and all 3 of the Shadows.  
On the left there is a group of boxes that display the current colour of each component or part of the 
character.  The box below it shows the colour of the component that is currently selected.   

To change the colour, select the component to change (Character, Edge, or Shadow) then use the 
controls on the right to select the colour.  There are five ways to select a colour.  You can use a colour 
picker, colour sliders, select a colour from a preset palette, set the colour to a gradient, or set the 
colour to a texture.   

Press one of the 5 buttons to select which method you want to use to select the colour.   

There are 5 different methods you can use to select colours, these are: 

Colour Picker, Colour Sliders, Colour Palette, Colour Gradients,Textures 

Colour Picker 

The colour picker lets you select a colour using a visual approach.  You can set the top and bottom 
colours separately.  If the top and bottom colours are different, the Character, Edge, or Shadow will 
be drawn with a smooth colour spread between the top and bottom.  One of the controls in this box is 
used to select the Hue (red, yellow, green, blue, etc) of the colour.  When a new hue is selected the 
other colour box will change to reflect the new hue.  You can select any colour from this box just by 
clicking the mouse on the desired colour.   

You can also vary the Transparency and the amount of External video levels that the text component 
will be drawn with.  Transparency will let whatever is behind the component to show through.  Setting 
the Video Level draws the component with a mixture of background video and a colour.  The higher 
the video level, the more dominant the background video will appear.   

The "Illegal Colour Indicator" will appear red if the selected colour is an illegal NTSC or PAL colour.  It 
will appear green if a legal or compatible colour is selected.   
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Colour Sliders 

The colour sliders let you select the colour using a numerical approach.  You can choose whether you 
want to define RGB (red, green, blue) values or HLS (Hue, Luminance, Saturation) values.  The top 
and bottom colours can be set separately.  If the top and bottom colours are different, the Character, 
Edge, or Shadow will be drawn with a smooth colour spread between them.   

You can also vary the Transparency and the amount of External video levels that the text component 
will be drawn with.  Transparency will let whatever is behind the component show through.  Setting 
the Video Level draws the component with a mixture of background video and a colour.  The higher 
the video level, the more dominant the background video will appear.   

The "Illegal Colour Indicator" will appear red if the selected colour is an illegal NTSC or PAL colour.  It 
will appear green if a legal or compatible colour is selected.   

Colour Palette

You can select from any of the 64 preset colours from the colour Palette.  The top and bottom colours 
can be set separately.  If the top and bottom colours are different, the Character, Edge, or Shadow 
will be drawn with a smooth colour spread between them.   

The "Illegal Colour Indicator" will appear red if the selected colour is an illegal NTSC or PAL colour.  It 
will appear green if a legal or compatible colour is selected.   

You can also select Background Video as the colour just by pressing the "Background Video" button.  
To modify the colour palette, double click on the entry that you want to modify.  The Colour Palette 
Editor will appear.  This lets you change the colour of each palette entry.   
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Colour Gradients

Each project in the Title Composer can have as many as 64 preset colour gradients defined.  They 
can be either linear gradients or area gradients.  A Linear Gradient can have up to 16 colour points 
and can be rotated up to 90 degrees in either direction.  An area gradient can set each corner to a 
different colour and the colours will create a smooth blend between the colours.  A centre colour point 
can also be added to create a 5-point colour gradient.  The centre point can be positioned anywhere 
within the colour gradient.  This is very useful for creating Highlighted colours.   

You can modify a colour gradient by double clicking on the one you want to modify.  The Colour 
Gradient Builder will then appear.   

The Colour Gradient Builder can then be used to select the type of gradient, as well as the colour and 
position of the points in the gradient.   

Colour Textures 

The Textures button lets you apply a texture to any of the text components (Character, Edges, or 
Shadows).  Select any of the loaded textures by clicking the mouse on the desired texture.  There can 
be up to 16 textures loaded for each page.  GIF, TIF, TGA, BMP, PCX, JPG, or JPEG images can be 
used as textures.   

To load a new texture, double click on the position that you want to modify then browse and select the 
image that you want to load as the new texture. 
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Layers Tab 

Title Composer can place text on multiple layers.  Up to 1000 layers can be used on each page.  
These layers are completely independent of each other.  Changing something on one layer will not 
affect the text on the other layers.  Each layer can be assigned a unique name.  The "Layering Order" 
list shows the current order of the layers.  The Top layer in the list is the front layer of the page.  A 
layer is in front of all of the layers that are listed below it in the layering list, and behind all of the layers 
that are listed above it.  Each layer can be moved in front of, or behind the other layers.  This is done 
by using the buttons to move the layer to the top layer, Up 1 Layer, Down 1 Layer, or to the bottom 
layer.  The order of the layers can also be changed by dragging it from its current position to the new 
position in the "Layering Order" list.   

Individual layers can be hidden so that they do not cover the lower layers that you are working on.   

To create a new layer, press and hold down the <Ctrl> key, then click the left mouse button where 
you want the new layer to appear on the screen.   

Layer Selection - even though a layer can be selected through the "Layers" tab, sometimes an 
element on one layer covers another (for instance, a letter over a shape) and clicking the left mouse 
button on the display will select the uppermost element no matter what layer is manually selected. 
This is handled by clicking repeatedly on the same area, which will select layers further down the 
chain with each mouse click. 

Positioning Tab 

The Positioning tab has the buttons that are used to Wrap and Unwrap words, Centreing, and 
Justifying rows, entire layers, and entire pages.  The text can also be fine positioned by using "Fine 
Positioning" buttons.   

The text can also be positioned by dragging the Cursor Handles with the mouse, or by holding down 
the right mouse button and dragging the selected text to the desired position. 
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Row Spacing Tab 

These controls are used to change the row leading (spacing) of the cursor row, the entire Layer, or 
the Entire page.   

Shapes Tab 

Shapes are boxes that you can control the roundness and aspect ratio of.  Once a shape has been 
placed on the page you can size it, colourize it, add edges and shadows to it, and even rotate it.  In 
fact you can do anything to a shape that you can do to a character (except change its’ typeface of 
course).  A foreground shape gets inserted into the current layer at the cursor position.  A background 
shape gets added to a new layer that is behind the currently selected text. 

The aspect ratio of the shape can be changed from tall and skinny to very wide.  The roundness of 
the shape can be set to any value from 0 to 100%.  A roundness of 0% creates a shape that has 
square corners.  A roundness of 100% creates a shape that is either a circle or an ellipse (depending 
on aspect ratio).  A value between 1 and 99% creates a box that has rounded corners.  The amount 
that the corners are rounded is determined by the roundness setting.   

Logos Tab 
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Full colour logos may be added to the page.  As many as 16 different logos can be added to a page.  
The logos can be loaded directly from GIF, TIF, TGA, BMP, PCX, JPG, or JPEG images.  If the 
selected logo image includes an alpha channel, the alpha channel is supported. 

When you Press the "Add New Logo" button, a window appears that allows you to select the logo 
image that you want to place on the page.  Once a logo is placed you can size and edge it just like 
you would a character.   

Background - Image Tab 

There are two types of backgrounds that can be added to the pages.  A background graphic, or 
background colours.  A GIF, TIF, TGA, BMP, PCX, JPG, or JPEG image can be loaded as the 
background Graphic.  If the background Graphic includes an alpha channel, the alpha channel is 
supported.   

A background graphic can be displayed Full screen, Original Size, or Tiled.  When a background 
graphic is loaded as Full screen the graphic is scaled so that it appears full screen.  When a 
background graphic is loaded in its original size, it will not be scaled.  A set of buttons will appear to 
allow you to position the background graphic on the page.  Tiling a background graphic that is smaller 
than the screen will repeat the graphic horizontally and vertically to fill up the entire page.   

If you select the "No Graphic" button, no background graphic will appear.  The background video will 
be displayed as the background.   
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Background - Colours Tab 

Background colour boxes can be added to the page.  You can apply a solid colour (with transparency 
and Background video) or you can apply a colour gradient (linear, 4 point, or 5 point).  You can even 
apply a texture to a background colour box.   

As many as 32 colour boxes can be placed on each page.  The layering order of background colour 
boxes can be changed.   

Text Substitution Tab 

The Text Substitution Tab is used to control the Text Substitution Variables and the Template Fields 
on a page. 

Text Substitution variables are used to display data that may change from time to time.  These can be 
things like Temperature, Vote Counts, Sports Scores, or any other data that you may want to 
automatically update.  To enable this feature you must have an optional plug in that may be 
purchased from Datavideo, Third Party Vendors, or you can write your own. 

Template Fields are used when creating Template pages.  This is the text that the user will be 
prompted for when a Template Page is used to create a Title Page. 
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Page Transition Tab 

The Page Transition Tab is used to select the Display Transition to use when the page is displayed.  It 
also sets the speed of the transition (Transition Duration) and how the long page will display when 
auto-sequencing. 

Status Bar 

The Status Bar (shown above) at the bottom of the screen displays the current status of the program.  
It is divided into 6 panes.  The first pane displays a one line HINT about the Toolbar button or Menu 
entry that the cursor is currently pointing to.  The next pane shows the current Mouse position.  The 
third pane shows the current Cursor Position.  The fourth pane shows the name of the current layer.  
The fifth pane shows the current typing mode (insert or overwrite).  The last pane displays the current 
row and column position of the cursor within the layer 

Text Editing 
The easiest way to learn how to use the Title Composer is to use it.  In this section we will create 
some pages.  They may not always be pretty, but they will demonstrate how to do the various 
functions that the Title Composer has to offer. 

Title Compose Window 
The Title Compose window is where you compose your pages. This window displays the title graphic 
that you are working on as you compose it.  If this window is smaller than the actual title graphic that 
you are creating, the title graphic will be scaled to fit this window.  If the title graphic is too small to 
see, try one of the following: 

Maximize the Title Composer window. 

Use a higher resolution VGA mode (i.e. 1024 by 768).  

Use the View menu to turn off other Title Composer windows to make more room for the Title 
Compose Window. 

Select the View Title Full Size command from the View menu to make the title compose window full 
size. 

Typing Text 
To enter text in this window, point the mouse to where you want the text to appear, and press the left 
button. A rectangle appears where you clicked the mouse. This is the text cursor. It shows where text 
will be entered.  Now type the message “I Really like the Title Composer”, the text will appear on the 
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VGA screen as you type it. If you are running on a system that has a separate video output, you will 
notice that the text also appears on that screen. 

If the text is too big to fit on the screen, select a smaller text style from the Style Gallery (on the right 
side of the screen) and throw away the page with the big characters by creating a new page again. 
Then re-type the message “I Really like the Title Composer” with the smaller text style. 

Moving the Cursor 
You can use the cursor movement or Arrow keys to move the cursor around in this window, or you 
can use the mouse to point to where you want the cursor to be placed and click the left button. 

The Arrow keys move the cursor one character or row in the direction of the arrow.  

The <Home> key moves the cursor to the beginning of the row if it’s not already there. If the cursor is 
at the beginning of the row and you press the <Home> key, it will move to the beginning of the layer.   
If the cursor is already at the first character of the layer, the <Home> key will move the cursor to the 
beginning of the “Main” layer.   

The <End> key moves the cursor to the end of the row if it’s not already there. If the cursor is already 
at the end of the row, it will move to the end of the layer.  If the cursor is already at the end of the 
layer, the <End> key will move the cursor to the end of the “Main” layer. 

Editing Text 
Using the text we just typed in move the mouse over the “R” in “Really” and press down the left button 
on the mouse. While holding down the Left button, drag the mouse to the “i” in “Like” and release the 
mouse button. Notice how the cursor expands to cover the text “Really Li”.  This is the text that is now 
selected. Any operations done to the text will be done to the text that is selected. Press the <Del> 
key. The text that was selected was deleted.  To get this text back, hold down the <Ctrl> key and 
press the <Z> key (you could also press the UNDO button in the toolbar).  The last operation (delete 
in this case) is undone.  

The Title Composer will let you UNDO as many as 1000 operations. 

Move the cursor to the “P” in the word “Power”. Hold down the <Shift> key and press the <Enter> key. 
This splits the row into two rows. A new row is created under the current row and the character that 
the cursor is on, and all characters after it, are moved down to the new row. 

Press the <Enter> key to move the cursor to the beginning of the next row. Hold down the <Shift> key 
and press the <Ins> key. This inserts a new row at the cursor position. Now type “Datavideo”.  Let’s 
delete this new row. We could use the UNDO function, but let’s use the delete row function instead.  
Hold down the <Shift> key and press the <Del> key. The cursor row is deleted and all rows 
underneath it move up to take its place. 

Move the cursor to the “R” in “Really”. Delete this word by holding down the <Ctrl> key while pressing 
<Del>.  The entire word is deleted and all text to the right of it moves over to fill in the space. Move the 
cursor to the “i” in “like”. Type the letters “ove”. The new letters replace (or overwrite) the text already 
on the screen.  The typing mode can be changed to “Insert” (see the “Insert Mode” command in the 
“Settings” menu).  

Move the cursor to the beginning of the second word on the top row. Insert five (5) spaces by holding 
down the <Alt> and pressing the <Ins> key 5 times. Now type the characters “Just”. This enters a new 
word in the space that you just inserted (4 characters for the word, 1 character for the space).  

The functions that you just learned (as well as others) can also be invoked by using the commands in 
the “Edit” menu. This menu also shows the keyboard short cut keys for these commands in case you 
forget them. 
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Saving the Page 
Before we go through the “Erase Text” functions, let’s save the page so we can use it later.  Select 
the “Save Page” option from the “File” drop down menu, or press the Third button (with the floppy disk 
icon) in the Toolbar.  Since this page has not yet been named, you will be prompted to enter a name 
for it.  Once the name has been entered, Let’s call it FIRST, press the “Save” button and the page will 
be saved to the current project.  Notice that a small “PICON” of the page appears in the Project 
Manager window along with the name of the page. 

Erasing Text 
The “Edit” menu has commands for erasing text. You can erase text from the cursor position to the 
end of the row, from the cursor position to the end of the page, or all of the text on the page. 

Move the cursor to the “V” on the first row, then go to the “Erase Text” option in the “Edit” menu and 
select “to End of Row” command.  Notice that all of the text from the cursor position to the end of the 
row is erased. 

Select the “to End of Page” command and all of the text from the cursor position to the end of the 
page is erased. Select the “Entire Page” command, and all of the text on the page is erased. 

Backspace
If you make a mistake while typing (such as typing the wrong character) just press the <Backspace> 
key.  This will move the cursor to the previous position and erase the character there.  If the system is 
in Insert mode, the character will be deleted.  You can then type the correct character. 

Using Tabs 
The Title Composer allows you to set up to 16 tabs per page.  These tabs specify horizontal positions 
on the screen. Columnar text can be aligned to the tabs.  If the Tab Display is enabled, the tab 
positions appear as vertical lines the entire height of the screen.   

The tabs behave differently depending on the typing mode.  In the Insert mode, pressing the <Tab> 
key will insert a tab character at the cursor position.  All text to the right of the new tab will be moved 
to the next tab position.  Pressing the <Tab> key in the Overwrite typing mode will move the cursor to 
the character at the next tab position.  If no tab is set to the right of the cursor, the cursor will move to 
the beginning of the next row. 

The width of the Tab character is automatically adjusted so that the next character is placed at the 
next tab position.  If no tab is set to the right of the tab character, it is treated the same as a space.  
Changing the text to the left of the tab character (by entering more text or changing the size of the 
text) will not move the text that you have placed at the next tab position unless the text becomes too 
big to fit in the allotted space. 

Normal typing will not overwrite a Tab character (even in the Overwrite typing mode).  Any text that is 
entered before the tab will be inserted at the cursor position and the width of the tab will be adjusted 
to keep the text at the next tab position from moving.  To get rid of a Tab character, use the 
<Backspace> or <Del> key. 

The tab positions are stored with the page.  When a page is recalled from the disk, the tab positions 
that the page was created with are loaded with it. 

For more information on default set tabs, setting tabs, deleting tabs, and tab display see the section 
titled “Setting Up Tabs”. 

Row Space Allocation 
As text is entered, sized, and repositioned, rows of text may begin to overlap each other, or may 
appear with too much spacing between them.  To set the Row spacing back to what it should be 
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(based on the text on the row), press the “Reset Row Spacing” button in the shortcuts window to reset 
the height of every row on the current page. 

Keyboard buttons 
Home 
Press the <Home> key to move the cursor to the first character of the row.  If the cursor is already on 
the first character of the row, pressing the <Home> key will move the cursor to the first character 
position of the first row of the layer.  If the page is a Credit Roll, it will scroll down until the very first 
row of the page is shown.  If the page is a Crawl, the page will scroll right to show the first character. 

End
Press the <End> key to move the cursor to the last character of the row.  If the cursor is already on 
the last character of the row, Pressing the <End> key will move the cursor to the last character of the 
layer.  If the page is a Credit Roll or a Crawl page, it will scroll until the last character appears. 

Page Up 
Pressing the <Page Up> key will move the cursor to the last character on the screen unless the page 
is either a Credit Roll or a Crawl.  If it is a Credit Roll, it will scroll up the height of the screen.  If the 
page is a Crawl, the text will scroll left the width of the screen. 

Page Down 
Pressing the <Page Down> key will move the cursor to the home position screen unless the page is 
either a Credit Roll or a Crawl.  If the page is a Credit Roll, the page will scroll down the height of the 
screen (if there is text above the screen).  If the page is a Crawl, it will scroll right the width of the 
screen (if there is text to the left of the screen). 

Setting Cursor Position with the Mouse 
The cursor can be moved with the mouse.  Move the mouse pointer to the desired position and click 
the left button.  The cursor will move to the character being pointed to.  If characters are overlapped, 
continue to click the left button until the desired character is selected 
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Text Styles 
One of the most amazing things about Title Composer is the amount of control you have over the text 
style.  Each character is made up of six different components.  These are the character, two edges, 
and three shadows. 

Each of these six character components can be set to either a solid colour, a vertical colour spread 
from the top to the bottom of the character, a colour gradient that you can define, or a texture. 

You can select a TrueType Typeface for the character and control the Height, Width, Italics Angle, 
Rotation, Kerning, and the Blur of the character. 

For each edge you can select the Edge Type, Direction, Depth, and the Blur.  For any of the three 
shadows you can select the shape (to be the same as the Character, Edge 1, or Edge 2) and the 
offset from the character.  The shadow can be offset from a character by as much as 100 pixels 
horizontally and vertically. 

Many of the text style attributes (height and width for example) are represented numerically.  These 
numerical attributes can be modified by controls that are either absolute or relative.  An absolute 
control will set all of the selected text to the new value.  A relative control will change all of the 
selected text by the same amount. 

To illustrate the difference between absolute and relative, let's assume there is a word on the screen.  
The size of the first character of the word is 50 scan lines; the rest of the word is 25 scan lines high.  If 
you select the entire word and use a relative control to increase the height of the first character by 25 
scan lines from (50 to 75 scan lines), the height of the rest of the word will be increased by 25 scan 
lines to 50 scan lines. 

If you use an absolute control to set the height of the first character to 60 scan lines, the height of the 
entire word will be set to 60 scan lines (they won't maintain their height relative to each other). 

Character Styles 
To change the character style, select the Character Tab in the Control Tab Window.  The controls for 
adjusting the character style will be displayed as shown below. 

This control tab window has 6 groups of controls to control numerical character attributes.  It also has 
a Cursor Handle Button, a Typeface selection box, and a button that you can press when you want to 
load new Typefaces. 

The numerical control groups are: 

Height 
Width 



41 

Italics 
Rotation
Kerning 
Blur

Each group of numerical controls is made up of 4 controls.  The top control in the group (the one with 
the icon) is a drag button.  The drag button is the relative control of the group.  To use the drag 
button, move the mouse over it, press the left mouse button, and drag the mouse.  Moving the mouse 
up or to the right will increase the value.  Moving the mouse down or to the left will decrease the 
value.  The other three controls in the group are the absolute controls. 

The absolute controls consist of a number box and two small buttons to the right of it for increasing 
and decreasing the value.  The value in the number box can be entered directly by moving the mouse 
over the number, double clicking the mouse (this will highlight all of the digits in the number), and 
entering the new value.  Pressing the increase button to the right of the value can increase the value.  
If you hold this button down the value will continue to increase until you release the button.  To 
decrease the value, press the decrease button.  Holding down this button will continue to decrease 
the value until you release it. 

If you move the mouse over the number, then press and hold down the left mouse button, you can 
change the value by moving the mouse.  Moving the mouse up or to the right will increase value.  
Moving the mouse down or to the left will decrease the value.  When you have the desired value, 
release the left mouse button. 

The Cursor Handle Button performs two functions.  It allows you to turn the cursor handles on and off.  
It’s also there as a reminder as to what each cursor handle is used for. 

The Typeface selection box lets you select a different Typeface and there is an "Add New Typefaces" 
button that you can press when none of the 25 typefaces that are currently loaded are what you want. 

Let's explore these buttons a little closer.  Create a new page by pressing the New Page icon in the 
toolbar and select a Still page type.  From the style gallery select a reasonably sized text style.  Then 
type the word TEST in all capital letters.  Press the home key to move the cursor to the first “T” in the 
word “TEST”. 

Move the cursor over to the Height Drag Button, press and hold down the left mouse button and move 
the mouse up.  Notice that the size of the character increases.  Release the left mouse button. 

Drag the cursor across the entire word to select it.  Move the mouse over the Height Drag Button, 
press and hold down the left mouse button, and move the mouse down.  Notice that the height of 
every character in the word decreases by the same amount.  The value of the number box is changed 
to display the current height of the first character that is selected.   

Now let's see how the absolute controls behave differently.  Move the mouse to the height number 
box and double-click it.  This will highlight all of the digits.  Re-enter the digits exactly as they were 
before (if they were originally 48, enter 48) and press the <Enter> key.  Notice that all of the 
characters became the same size as the first character; they did not maintain their relative character 
heights. 

The height of the characters can be varied and set to any size between 600 scan lines high and 
negative 600 scan lines high.  The negative character height will draw the characters inverted (upside 
down).  Try experimenting with the height controls to see how they affect the characters. 

Changing the width of the characters will make them appear thinner or wider.  The width can be 
varied anywhere between 10 percent of normal (very thin) to 500 percent of normal (five times their 
normal width).  A width of 100% is the normal width for the character.  Try experimenting with the 
width controls to see how they affect the characters. 
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The italics angle of the text can be varied up to 45 degrees in either direction.  A negative italics angle 
will slant the characters to left, the positive italics angle will slant the characters to the right.  Try 
experimenting with the italics controls to see how they affect the characters. 

Each individual character, or group of characters, can be rotated up to 360 degrees in either direction.  
A positive value will rotate the text clockwise, while a negative value will rotate the text counter 
clockwise. 

The kerning controls allow you to change the spacing between the characters.  A negative value will 
move the characters closer together.  A positive value will move the characters further apart. 

The amount of blur on the characters can be changed using the blur controls.  A blur value of 2 gives 
you a crisp sharp character; a blur value of 12 gives you a very fuzzy character.  The blur of the 
character and the blur on each of the two edges can be set independently of each other.   

Cursor Handles 
Cursor Handles are points on the cursor that allow you to click and drag the text around the screen.  
With these handles you can move, size, rotate, and italicize the text.  The Cursor Handle Button (on 
the right hand side of the character tab window) is used to turn the Cursor Handles on and off.  It also 
has a little diagram that shows what each handle is used for.   

Turn the cursor handles on by pressing the Cursor Handle Button.  Notice that eight small boxes 
appear around cursor.  Each of these small boxes is a handle.  You can move the selected text by 
clicking on the handle in the lower left corner and dragging the mouse.  Each time you pause the 
mouse, the text will be redrawn at the new position.  If you only want to move the text horizontally 
(without affecting the baseline alignment) you can use the handle on the left side of the cursor.  If you 
accidentally move the mouse vertically while dragging this handle, the text will not move vertically.  
Using the handle on the bottom of the cursor will only move the text vertically; it will not allow it to 
move horizontally. 

Use the handle at the top of the cursor to adjust the height of the characters.  When you change the 
size of the cursor by dragging this handle, the height of the text will be changed to match the cursor 
size.  The relative size of each selected character will be maintained. 

Use the handle on the right side of the cursor to adjust the width of the text.  Dragging this handle left 
or right will change the relative width of each selected characters.  When you change the width of the 
cursor by dragging this handle, the relative width will be adjusted to fit within the new cursor size. 

Dragging the handle on the upper right corner of the cursor will adjust both the height and width of the 
text.  Dragging the handle on the lower right corner of the cursor will rotate the selected text.  
Dragging the handle on the upper left corner of the cursor will change the italics angle of the text. 

When you are through using the cursor handles, and you no longer want them to be displayed, press 
the Cursor Handle Button again to turn the handles off. 



43 

Typefaces
The typeface selection box shows the current typeface.  If you open this box up by pressing the down 
arrow on the right hand side, all of the typefaces that are currently loaded will appear.  Click on any 
typeface in this list to select it.  When a new typeface is selected, the selected text will be redrawn 
with the new typeface. 

Loading New Typefaces 
Title Composer can load two types of typefaces, the Datavideo format or TrueType format.  The 
Datavideo format is a proprietary format.  The typefaces that came with the program are in this format.  
The TrueType format is the most popular format and has the widest selection of typefaces.   

You can load up to 25 typefaces for each project.   

When you use typefaces on a page, the system keeps track of which typefaces are needed to display 
the page.  If the loaded typefaces do not match the typefaces needed by the page, the correct 
typefaces are automatically loaded. 

To load new typefaces press the "Add New Typefaces" button.  When this is done the Load New 
Typefaces window will appear as shown below. 

Load New Typefaces dialog box 

The typefaces that are currently loaded are listed on the right hand side of this window.  The 
typefaces that are available to be loaded (in the current directory) are listed on the left hand side.  The 
current directory is displayed in the centre. 

Select the typeface format (TrueType or Datavideo) that you want to load.  All of the typefaces in the 
current directory of the selected format will appear on the left side under “Available Typefaces”.  If the 
typefaces are TrueType, the full name of the typeface is shown in the actual typeface (for example, 
the name Helvetica will appear in the Helvetica typeface, the name Times New Roman will appear in 
the Times New Roman typeface).  You can use this feature to preview the typefaces without the need 
to load them first.  To get a better look at a typeface, click on it in this list.  A larger sample of this 
typeface will appear. 

If the desired typeface is not in the current directory, select the proper directory.  Your PC system 
typefaces are usually stored in the "C:\WINNT\FONTS" or the "C:\WINDOWS\FONTS" 
directory\folder. 

The typefaces do not need to be installed on your system.  You can load typefaces directly from a 
CD-ROM disc.  When you load a TrueType typeface, a copy of it is made on your hard drive (in the 
POWERCG\TYPEFACE folder).  You can then remove the CD-ROM disc and the program will still be 
able to find the typefaces when it needs them. 
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To load a new typeface, select the position that you want to load it into in the “Loaded Typefaces” list, 
select the typeface to load in that position from the “Available Typefaces” list, then press the load 
button.  The new typeface will appear in the “Loaded Typefaces” list and the next position in the 
“Loaded Typefaces” list will be selected.  The typeface may also be loaded by double-clicking on it in 
the “Available Typefaces” list.   

When you have finished loading typefaces press the “Done” button and the Load New Typefaces 
window will disappear.  Notice that the new typefaces now appear in the Typeface Selection Box. 

Scope Selection
Now that we have the basics of character attributes down, let's try something a little more advanced.  
Create a new page, and set the Page Type to the Still.  Set the character Height to 24 scan lines, the 
Width to 100 percent, Italics to 0 degrees, and Rotation to 0 degrees.  Set the Kerning to 0 and the 
Character Blur to 2.  Selected a clean/easy to read typeface such as Boston Black, Futurist, or 
Bassett Bold.  Now type the following three lines of text: 

The quick Brown Fox 
jumped over the 
lazy dogs back. 

Place the cursor on the M in the word “jumped” and select a different typeface.  Notice that only the 
character under the cursor changed.  If the toolbar is visible (above the title compose window) you'll 
see a selection box with the words "Selected Text".  This is called the “Scope Selection Box.” This 
selection box is used to determine how much text the Text Style changes will affect.  If the toolbar is 
not visible, display it by selecting the “Display Toolbar” command from the “View” menu.  Open this 
box by pressing the down arrow and the following options will appear: 

Selected Text 
to End of Word 
Entire Word 
to End of Row 
Entire Row 
to End of Layer 
Entire Layer 
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Entire Page 
Change this selection to “to End of Word”, then change the rotation angle to minus 10 degrees.  
Notice that every character from the M to the end of the word is rotated.  Go back to the toolbar and 
change the selection to “Entire Word”.  Increase the height to 48 scan lines.  Notice that the height of 
the entire word changed.  Now select the “to End of Row” entry from the scope selection box and set 
the width to 50 percent.  Notice that all text from the cursor position (the M in jump) to the end of the 
row changed its width. 

Set scope to “Entire Row” and select a new typeface.  Every character on the row is now drawn with 
the new typeface.  Select “to End of Layer” from the scope selection box and set the height to 60 scan 
lines.  Every character from the cursor position to the end of the row, and every character on every 
row after the cursor changed to the new height.  Now select “Entire Layer” as the scope and select a 
new typeface.  Notice that every character on the page changed to the new typeface.  There is one 
more entry in the scope selection box that we have not discussed yet.  It is “Entire Page”.  Selecting 
this entry would change all of the text on all of the layers if we had multiple layers on the page.  You'll 
find out more about this when we discuss Layers later on. 

When “Selected Text” is chosen, the changes are applied to the character or group of characters that 
are selected by the cursor.  To select multiple characters, move the mouse to the first character to 
select, hold down the left mouse button, and drag the mouse to the last character to select.  Dragging 
the mouse will not select text that is on more than one row unless the <Shift> key is held down while 
the mouse is being dragged. 

Edges
To change the Edge Styles, select the Edges Tab in the Control Tab Window.  The controls for 
changing the edges will be displayed as shown below. 

This control tab window has 2 complete sets of controls for controlling both edges.  The controls on 
the left are used to set Edge 1; the controls on the right are used to set Edge 2.  Since both sets of 
controls are identical, we will discuss both of them at the same time. 

Each set of edge controls are made up of four groups of controls.  One group selects the Edge Type, 
another group selects the Direction of the edge, and there are two groups used to control the 
numerical values Edge Depth and Edge Blur. 
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Edge Type 
The Edge Type is controlled by a group of five buttons.  These buttons are called radio buttons 
because only one button can be selected at the time (just like buttons on the car radio).  Pressing one 
button will deselect the others.  These buttons are used to select the edge type and to indicate the 
current edge type.  The edge types that can be selected are as follows: 

No Edge 
Shows just the characters without any edge. 

Full Surround Border
Displays the characters with a border around them.  The border has equal depth on all sides 
of the character.  The depth of the border is set by the Depth controls. 

Extruded Shadow 
Extruded Shadows appear connected to the character.  This gives the characters sort of a 
three-dimensional look.  The direction of the shadow is determined by the Direction controls, 
and the depth is set by the Depth controls.  

Highlighted Shadow 
A Highlighted Shadow is very similar to an extruded shadow.  However a fine border appears 
to highlight the character.  The direction of the shadow is determined by the Direction controls, 
and the depth of the shadow is set by the Depth controls. 

Offset Shadow 
An Offset Shadow is separated from the character.  This makes it appear as though the 
character is above the background and is casting a shadow on it.  The direction of the shadow 
is determined by the Direction controls, any offset of the shadow is set by the Depth controls. 

Pressing the appropriate button selects the edge type. The button then appears depressed to indicate 
the current edge type. 

Edge Direction 
The direction of the extruded shadow, highlight shadow, and offset shadows can be controlled.  The 
direction control group (shown below) controls the direction. 

There are eight buttons around the outside of this group.  Each button 
represents one of the eight possible directions (Upper Left, Up, Upper Right, 
Right, Lower Right, Down, Lower Left, and Left).  Pressing one of these 
buttons will select the corresponding Shadow Direction.  When the direction is 
selected, the button appears depressed to indicate the current direction. 

There is also a button/indicator in the middle of the Direction Selection Buttons.  
This also indicates the current shadow direction.  Pressing this button will 
advance the shadow direction clockwise to the next direction. 
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Edge Depth 
The depth of the edge is a numerical parameter that can be varied from 0 to 99 pixels.  An edge depth 
of zero will not be seen unless you make the edge blurrier than the character.  Setting the edge depth 
to 99 scan lines will make an extremely deep edge that may slow down the drawing of the characters.  
If you want a really deep edge like this, and you have a slower CPU, I suggest that you compose the 
page using a smaller edge first.  This lets you compose the page without being slowed down too 
much.  After the text is typed, you can make the edges as deep as you want.  The edge depth will not 
have any effect on the edge if the Edge Type is No Edge. 

The numerical controls in this group have both Relative and Absolute controls.  They work just like the 
numerical controls on the Character Tab. 

Edge Blur 
The amount of blur on the edges can be changed by the controls in this numerical control group.  A 
Blur setting of 2 gives a crisp sharp edge; a blur setting of 12 gives you a fuzzy edge.  The Blur of 
each edge and the character can be set independently of each other. 

Shadows
The Title Composer can display each character with 3 independent shadows.  These are called 
Shadow 1, Shadow 2, and Shadow 3.  Shadow 1 is drawn behind the character and in front of Edge 
1.  Shadow 2 is drawn between Edge 1 and Edge 2.  Shadow 3 is drawn behind Edge 2.  You can 
control the shape and offset (horizontal and vertical) of each shadow independently.   

To change the Shadow Styles, select the Shadows Tab in the Control Tab Window.  The controls for 
changing the shadows will be displayed as shown below. 

This control tab window has 3 complete sets of controls for controlling all three shadows.  The 
controls on the left are used for Shadow 1, the controls in the middle are used for Shadow 2, and the 
controls on the right are used for Shadow 3.  Since all three sets of controls are identical, we will 
discuss all three of them at the same time. 

Each set of shadow controls are made up of 2 groups of controls.  One group selects the Shape of 
the shadow; the other group selects the shadows’ offset. 

To help demonstrate the Shadows, we should make both of the edges look significantly different from 
the character as well as each other.  Select the “Character” Tab.  Set the Height to 48 scan lines, the 
Width to 100%, the Italics and Rotation angles to 0 degrees, and the Blur setting to 2.  Now select the 
“Edges” Tab.  Set the Edge 1 type to “Full Surround”, set its’ Depth to 8 pixels, and set its Blur to 7.  
Set the Edge 2 type to “Extruded Shadow”, set it’s direction to “Lower Right” set its’ Depth to 30 
pixels, and its’ Blur to 12. 

We also need to set the character, edge, and shadow colours so we can easily tell them apart.  
Warning - this could end up looking ugly.  Select the “Colours” Tab; this will display the colour 
controls.  Press the “Palette” button to display the preset colour palette. 
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Press the “Character” button in the “Component” control group to tell the system that we want to 
change the Character colour (make sure both the “Top Colour” and “Bottom Colour” check boxes are 
marked).  Scroll down in the colour palette until the “White” entry appears and select it as the 
character colour.  Press the “Edge 1” button, make sure both the “Top Colour” and “Bottom Colour” 
check boxes are marked, and select a “Reddish” colour for it from the colour palette.  Press the “Edge 
2” button, make sure both the “Top Colour” and “Bottom Colour” check boxes are marked and select a 
“Greenish” colour for it from the colour palette. 

Let’s set the Shadow colours now.  Press the “Shadow 1” button; make sure that both the “Top 
Colour” and “Bottom Colour” check boxes are marked, and select a “Blue” colour for it.  Press the 
“Shadow 2” button; make sure that both the “Top Colour” and “Bottom Colour” check boxes are 
marked, and select a “Magenta” colour for it.  Press the “Shadow 3” button, make sure that both the 
“Top Colour” and “Bottom Colour” check boxes are marked, and select a “Yellow” colour for it.  Now 
we can definitely tell which component (Character, Edge, and Shadow) is which. 

Select the “Shadows” tab to display the “Shadows Control Window”.  Type the word “SHADOWS” on 
the screen then drag the mouse over the word to select the entire word. 

Select “None” as the shape of all three shadows.  Use the “Offset” controls for each shadows to set 
the offsets of each shadow to the following: 

 Vertical Offset Horizontal Offset 
Shadow 1    8    9 
Shadow 2 -26 -27 
Shadow 3 -40  30 

Shadow Shape 
The Shadow Shape control group is made up of 4 buttons (to select the shape of the shadow)  and an 
indicator (to indicate the current shadow shape). 

A shadow can be set to be the same shape as the Character, Edge 1, Edge 2, or it can be turned off.
To turn the shadow off, press the “None” button.  To make the shadow the same shape as the 
character, press the “Character” button.  To make the shadow the same shape as edge 1, press the 
“Edge 1” button.  And so on. 

As each shape is selected, the Current Shadow Shape Indicator (below the shape selection buttons) 
will change to indicate the current shadow shape.  You can also click on the Current Shadow Shape 
Indicator to advance the shape of the shadow to the next shape. 

Select the different shapes for Shadow 1.  Notice that when you select the shape for the shadow, it 
appears as blue (earlier, we selected blue as the shadow one colour) behind the Character and in 
front of Edge 1 (the red edge).  Do the same for Shadow 2 and Shadow 3.  Notice that Shadow 2 
(magenta) is drawn behind Edge 1 (the red edge) and in front of Edge 2 (the green edge).  Shadow 3 
(yellow) is drawn behind Edge 2. 

Set the shape of Shadow 1 to “Character”, the shape of Shadow 2 to “Edge 1”, and the shape of 
Shadow 3 to “Edge 2”. 

Shadow Offset 
The shadows can be offset from the character in any direction in single pixel increments.  The 
shadows can be offset horizontally from the character by as much as 100 pixels in either direction.  A 
negative value offsets the shadow to the left.  A positive value offsets the shadow to the right.  The 
shadows can be offset vertically from the character by as much as 100 scan lines.  A positive value 
places the shadow above the character; a negative value places the shadow below the character 
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The shadow offset controls for each shadow work very similar to the numerical controls in the 
“Character” and “Edges” tabs.  The offset drag button (shown below) can be used to control both the 
vertical and horizontal offsets. 

Dragging the mouse left or right will adjust the horizontal offset.  Dragging the mouse up or down will 
adjust the vertical offset. 

Click on the "H" in shadows to select it.  Click on the Shadow 1 Vertical Offset Number Box and drag 
the mouse down.  The blue shadow (Shadow 1) moves down when you move the mouse.  Click on 
the Shadow 1 Horizontal Offset Number Box and drag the mouse to the right.  Shadow one moves to 
the right when you move the mouse. 

Notice that Shadow 1 on the “H” character is in a different position than Shadow 1 on the other 
characters.  Drag the mouse across the entire word to select all the characters.  Position the mouse 
over the Shadow 1 Offset Drag Button and press the left mouse button.  Now move the mouse around 
while holding down left button.  Notice that shadow 1 on all of the characters moves with the mouse, 
and that Shadow 1 on the “H” maintains its position relative to the rest of the characters. 

Try experimenting with the offsets for Shadow 2, and Shadow 3.  You'll see that they work exactly the 
same way as Shadow 1. 

Save this page with the name “SHADOWS”. 

Text Colours 
Select the “Colours” Tab in the Control Tab Window to adjust the Text Colours.  This will display the 
Colours Control Window (shown below). 

The Colours Control Window has three main sections.  The first section (on the left) is used to select 
which component of the text (character, shadow 1,edge 1,shadow 2, edge 2, or shadow 3) to change 
the colour of.  The next section is a group of buttons used to select the method of choosing a colour 
(colour picker, colour sliders, colour palette, colour gradient, or textures).  The last section has the 
controls used in choosing a colour.  These controls change based on the method of choosing a colour 
that you have selected.   

Text Components 
The component group of controls contains six buttons for selecting which component of the text to 
change the colour of, (character, edges, or shadows).  To change the character colour, press the 
“Character” button.  To change the colour of edge 1, press the “Edge 1” button.  And so on.  When a 
new text component is selected, the colour indicator box in the lower left corner of this group is 
changed to display the current colour.  The colour indicator box displays the current colour as it is 
being modified. 
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The component section of the Colours Control Window has an indicator to show the current colour of 
each text component.  These boxes display the text components in the same order that they will 
appear on the screen.  The front box of this indicator shows the current Character colour.  The box 
behind it (that is offset down and to the right of it) shows the current Shadow 1 colour.  The box that is 
behind to both the Character and Shadow 1 indicators, displays the current Edge 1 colour.  The box 
behind and offset down to the right of the Edge 1 indicator, displays the current Shadow 2 colour.  
The box that is behind both the Edge 1 and Shadow 2 indicators, displays the current Edge 2 colour.
The box behind all of the others is the Shadow 3 colour indicator. 

If you click on any of these indicators, the component that it represents will be selected.  The 
appropriate component selection button will appear depressed to indicate the current component.  
The colour indicator box will also be changed to the colour of the selected component. 

Colour selection methods 
There are five different methods of selecting a colour.  These methods are as follows: 

Colour Picker  - lets you select the colour using a visual approach (see page 29). 

Colour Sliders - let you select the colour using a numerical approach (see page 30). 

Colour Palette  - lets you select a colour from a palette of 64 preset colours (see page 30). 

Color Gradient - A colour can be selected from a group of 64 user defined colour gradients. 
This may be either a linear gradient with up to 16 colour points that can be 
rotated up to 90 degrees in either direction.  It can also be an area gradient that  
can have four or five colour points defined (see page 31). 

Colour Texture - can be selected from any of the 16 textures that are currently loaded. 
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Grabbing and Applying Attributes 
When you enter new text it is entered with the Current Text Attributes.  The text attributes specify how 
the characters, edges, and shadows will appear.  The Current Text Attributes are the attributes 
displayed in the Character, Edges, Shadows, and Colours control tab windows.  These include the 
following:

Typeface 
Character Size 
Italics and rotation angles. 
Kerning 
Blur    (character and edge) 
Edge Style   (type, depth, direction) 
Shadow Appearance  (shape and offset) 
Colours   (character, edges, and shadows) 

When you overwrite text, the text keeps the attributes of the text that you are overwriting.  If you would 
like to apply the Current Text Attributes to text that is already on the page, use the "Apply Text 
Attributes" command.  Select the text that you want to change the attributes of, and press the "Apply 
Text Attributes" button in the Shortcut Buttons window. 

If you want to grab the text attributes from text that is on the page, press the "Grab Text Attributes" 
button in the Shortcut Buttons window.  This will make the text attributes of the character under the 
cursor, the Current Text Attributes.  The new character attributes will then be displayed in the 
Character, Edges, Shadows, and Colours control tab windows. 

Text Style Gallery 
The "Text Style Gallery" window is used to hold preset text styles.  This is the window on the right side 
of your screen with all of the different type of "A's" in it.  The Text Style Gallery is designed to give you 
quick access to text styles that you will use frequently throughout the project.  You can save 64 
different preset text styles in the Text Style Gallery.  However, you are not limited to just these 64 
styles. 

Before we begin, create a new page by pressing the "New Page" button on the toolbar.  The program 
will warn you that you are about to erase the current page.  Since we don't have a page that is really 
worth saving, press the "Yes" button.  If the program asks you which type of page to create, select 
"Still".  You now have a new blank page to work with. 

To enter text using one of the preset styles, select the desired text style (by clicking on it) and start 
typing.  Any new text that is entered will appear with the selected text style.  To select a different 
preset text style, click on it and start typing again. 

Select a text style that looks interesting and type "This is my first preset style".  Select another preset 
style and type "This is another one". 

To change the style of text that is already on the screen, select the text, then click on the style that 
you want to set it to.  Move the cursor to the first character and select another style from the style 
gallery.  Now, move the cursor to the next character and select another style.  Continue to do this for 
every character of the first two words of the page. 

Select the word "first" by moving the mouse to the "f", press the left mouse button, and drag the 
mouse over to the "t" until the entire word is selected.  Then select another text style.  Notice that the 
entire word is changed. 

Select the Character tab in the Control Tabs Window and adjust the Height of the word "first".  Even 
though the character style was set using a preset style, you can still modify the style of the text.  So if 
you have a text style that is almost what you want, go ahead and select it, then modify the attributes 
of the text you just changed the style of, doing this will not affect the preset style in the style gallery. 
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You can change the preset text styles.  Create a character on the page that has the style that you 
want to use as a preset, place the cursor on it, and move the mouse pointer to the entry in the Text 
Style Gallery that you want to set to this style, and press the right mouse button.  A pop-up menu will 
appear.  Select the "Set Style" command.  The text style of the cursor character will be copied to the 
style gallery. 

There are too many preset text styles to be shown at one time in the text style gallery.  You can use 
the scroll bar to scroll through the preset text styles.  I like to group styles that are used together, near 
each other in the Text Style Gallery. 

Save this page to the disk by pressing the "Save Page" button on the toolbar.  Give the page the 
name "STYLES" and press the "Save" button.  You should see its PICON in the project manager 
window. 

Layers
The Title Composer has 1000 layers available for text, shapes, and logos.  These layers are 
completely independent of each other.  Changing something on one layer will not affect the text on 
the other layers.  Each layer can be given a name.  Each layer can be moved in front of, or behind the 
other layers.  Individual layers can be temporarily hidden so that they do not cover up the other layers 
that you're working on. 

To work with layers, use the "Layer Controls" (shown below).  You can display these controls by 
selecting the "Layers” tab in the Controls Tab Window. 

Creating a New Layer 
Select a character height of about 48 scan lines.  Enter enough text to fill the entire screen.  Move the 
mouse near the left margin about halfway down the screen.  Create a new layer by holding down the 
<Ctrl> key while you press the left mouse button.   

The cursor is now positioned where you clicked the mouse on the new layer.  Notice that the 
"Layering Order” list has a new entry called "layer 1".  This is the top layer in the list, so it will be the 
front layer on the screen.  Now enter the text "This is a new layer".  Notice that the new text appears 
in front of the original text.   

Move the cursor to the second row of the text on the original (Main) layer by clicking the mouse on it.  
Notice that the name of the “Main” layer appears on the current layer on the status bar.  Insert a row 
at the cursor position by holding down the <Shift> key while you press the <Ins> key.  The text on the 
Main layer moved down to make room for the new row of text.  The text on Layer 1 did not move.  
That is what we mean when we say the layers are completely independent of each other. 

Selecting a Layer 
You can select a new layer just by setting the cursor position to a character that is on that layer.  
Move the mouse to any character on Layer 1 and click the left mouse button.  The cursor is moved to 
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the character that you clicked with the mouse, and the status bar is updated to show that you are now 
on Layer 1. 

You can also select a new layer from the "Layering Order” list.  When this is done, the cursor will be 
placed on the first character of the selected layer. 

Renaming Layers 
When the new layers are created, they are given a default name such as "Layer 1".  When that layer 
is selected the name appears on the status bar and in the "Layer Name" box in the Layers Control 
Window.  You can change the name of the layer just by entering the new name in the "Layer Name” 
box.  When the name is changed, the name appears in the "Layering Order” list and on the status bar. 

Changing Layer Priority 
When a new layer is created, it is given the highest priority so that it will be displayed in front of all the 
other layers.  The priority of each layer is displayed in the "Layering Order” list.  The top layer in the 
list is the highest priority layer and is in front of all the other layers on the page.  The bottom layer in 
the list is the lowest priority layer and is behind all of the other layers.  A layer is in front of all of the 
layers that are listed below it in the layering list, and behind all of the layers that are listed above it. 

Each layer can be moved in front of, or behind the other layers.  This can be done using the layer 
priority buttons (shown below). 

Move layer to top 
This gives the current layer the highest priority, and 
places it in front of all other layers 
Move layer up one layer 
This moves the current layer up 1 level in priority; this 
places it in front of the next layer up. 
Move layer down one layer 
This moves the current layer down one level in priority; 
this places it behind the next layer down. 
Move layer to bottom 
This gives the current layer the lowest priority, and 
places it behind all other layers. 

Dragging it from its current position to the new position in the “Layering Order” list can also change a 
layers priority.  Move the mouse to the layer that you want to change the priority of in the "Layering 
Order" list.  Hold down the left mouse button and drag the layers name to the desired priority.  The 
page will then be redrawn with the layer displayed at the new position. 
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Hiding Layers 
When you start getting a lot of layers on a page, and you need to make a change to something that is 
on a low priority layer, the things that you want to change may be difficult to see because of the layers 
in front of it.  There are two ways to make the low priority of layers more visible.  One way is to 
increase the layers priority, edit the text, then move the layer back to its lower priority.  The other 
method is to "Turn Off" the layers in front.  This is done by telling the program which layers you don't 
want to see. 

On the right hand side of the Layers Control Window are 2 buttons (“Displayed” and “Hidden”).  These 
buttons show whether or not the current layer is displayed or hidden.  To hide a layer, select the layer 
that you want to hide and press the "Hidden" button.  The page is then redrawn without the selected 
layer.  To turn the layer back on, press the "Displayed" button, and the page is redrawn with the layer.  

Another really neat thing that hidden layers allow you to do it is to easily create multiple pages that all 
have common information.  Place the text that is common to all pages on one or more layers.  Place 
text that is common to more than one (but not all) pages on other layers.  Then compose the text that 
is unique to each page on its own separate layer.  This gives you a master page. 

Copy the master page once for each page that you want to create.  And hide the layers that you do 
not want to show on each individual page.  If you ever need to modify the text, you can modify the 
master page (instead of each individual page) then copy the pages and hide the appropriate layers 
again.  This avoids any differences (such as positioning errors) in the pages. 

Deleting Layers 
If a layer has no text on it, you may want to delete it.  You can do this by selecting the layer and 
pressing the "Delete Layer" button in the Layer Controls Window.  If there is text on the layer that 
you're trying to delete, a warning message (like the one below) will appear telling you that if you 
delete the layer, all of the text on that layer will also be deleted. 

If you want to delete the text that is on this layer, press the "Yes" button.  Otherwise press the "No" 
button.

Moving Text 
Once the text has been entered, it can be moved around and positioned.  This can be done either 
automatically or manually.  Automatic positioning of pages consists of word wrapping, word 
unwrapping, centreing the text between the margins, justifying the text to the margins, or removing 
excess row spacing from between the rows. 

Manual positioning of the text allows you to move the text to nearly any position on the screen. 

To do automatic text positioning, use the “Positioning Controls” (shown below).  You can display 
these controls by selecting the “Positioning” tab in the Control Tab Window. 
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Word Wrapping and Unwrapping 
Let's start with a fresh page by pressing the "New Page" button on the toolbar.  A warning may 
appear telling you that the current page is going to be erased.  If this happens press the "Yes" button.  
Some system configurations will display a dialog box asking you to select the page type.  If this 
happens, press the "Still" button.  You now have a new page to work with. 

Set the character height to 48 scanline, and the character width to 100%.  Now enter the following text 
without pressing the <Enter> key "This Title Composer software is really pretty easy to use".  Notice 
that when you got to the right side of the screen, the cursor automatically went to the beginning of the 
next row. 

Some of the words extend beyond the right margins.  There are two common methods of fixing this.  
The first method is to make the text smaller so that it will fit.  The other method is to wrap the words 
that extend beyond the margin to the next row.  Since this section deals with word wrapping and 
unwrapping, let's try wrapping the words. 

The "Word Wrap/Unwrap" section of the "Positioning Controls Window" has four buttons.  These 
buttons are as follows: 

Wrap One Word 

Wrap All Words 

Unwrap One Word 

Unwrap All Words 

Word Wrap checks to see if the last word of the row extends beyond the right margin.  If it does, the 
word is moved to the beginning of the next row.  Word Unwrap checks to see if the first word of the 
next row will fit on the current row.  If it will, the word gets moved up to the row above. 

Move the cursor to the home position by pressing the <Home> key twice.  Press the "Wrap One 
Word" button (in the positioning controls window).  If the last word of the cursor row extends beyond 
the right margin, it gets moved to the next row. 

If there is a word that needs to be wrapped, one word gets wrapped to the next row each time you 
press this button.  If there is not a word that needs to the wrapped, pressing this button will move the 
cursor to the beginning of the next row.  Press the "Wrap One Word" button until all words that need it 
are wrapped to the next row and the cursor moves to the next row.  You could continue to wrap the 
entire page this way, but there is an easier way to do it.  Press the "Wrap All Words" button.  All of the 
words on the page that need to be word wrapped are moved to the next row. 



56 

Select all of the text on the page by selecting "Entire Page" in the scope selection box on the toolbar.  
Decrease the height of the text to 32 scan lines using any method that you prefer.  The rows of text 
got narrower so that you can now fit more text on each of the rows. 

Move the cursor back to the home position by pressing the <Home> key twice.  Press the "Unwrap 
One Word" button.  The first word of the next row should move up to the end of the cursor row if 
there's room for it.  Press the "Unwrap All Words" button.  Every word on the page will unwrap to fill in 
the excess space at the end of each row. 

Row spacing (Leading) 
Notice that when you decreased the height of the characters that the height of the rows did not 
automatically get smaller.  The rows now seem to be spaced too far apart.  To set the row to the 
height that they should be, press the "Preset Row Spacing" button in the shortcut buttons window.  
The height of each row will automatically adjust to what it should be for the height of the tallest 
character on the row. 

You can have more control over the rows spacing (leading) with the "Row Spacing" controls.  Display 
these controls (shown below) by selecting the "Row Spacing" tab in the control tab window. 

These controls are used to increase/decrease the spacing between the rows.  The row spacing can 
be increased by pressing the "More" buttons.  The row spacing can be decreased by pressing the 
"Less" buttons.  To set the row spacing back to what it should be (based on the text on the row) press 
the "Set Default Row Spacing" button. 
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The buttons in the "Change Row Spacing of" section of this window are used to select which row(s) 
we are going to change the row spacing of. 

Cursor Row Changes the row spacing of the row that the cursor is on. 

Entire Layer Changes the row spacing of every row on the current layer. 

Entire Page Changes the row spacing of every row on the page. 

Fine Positioning Text 
Individual characters, words, rows, layers, and the entire page can be fine positioned in single 
pixel/scan line increments.  Characters can be moved to any position on the row and can be made to 
completely overlap each other.  Smaller characters can be positioned inside of larger characters.  
Rows can even be positioned to allow text to overlap the text of other rows. 

There are three ways to fine position text around the screen.  One method is to use the cursor 
handles.  Another method is to drag the text by moving the mouse while holding down the right mouse 
button.  The final method is to use the fine positioning buttons in the positioning control tab window. 

To use the cursor handles, select the character tab in the control tab window and turn the cursor 
handles on by pressing the “Cursor Handles” button.  Little rectangles will appear around the cursor.  
These are the cursor handles.  The handle in the lower left hand corner will move the text both 
horizontally and vertically.  The handle on the left side of the mouse will move the text horizontally 
only.  Any accidental vertical movement of the mouse will not move the text vertically.  The handle on 
the bottom of the cursor will only move the text vertically.  Accidental horizontal movement of the 
mouse will not move the text horizontally. 

To move text with these handles, select the text to move by dragging the mouse over the desired text.  
Position the mouse over the handle that you want to use and the cursor will change to arrows that 
show which direction the text can be moved.  Press and hold down the left button of the mouse, then 
move the mouse.  The text will follow the mouse until you release the left mouse button. 

If the Cursor Handles clutter up the screen too much for your taste, you can turn them off by pressing 
the “Cursor Handles” button again (once you are finished moving the text). 

You can quickly move the text (both horizontal and vertical) without turning on the cursor handles.  To 
do this, select the text that you want to move and press and hold down the right hand button of the 
mouse.  As you move the mouse, the text will follow it until you release the right mouse button. 
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To use the fine positioning buttons to move the text, display the Fine Positioning Buttons by pressing 
the "Positioning" tab in the control tab window.  This will display the Positioning Controls Window as 
shown below. 

Use these buttons to do fine incremental positioning of text.  The single arrow buttons will move the 
selected text one pixel each time you press it.  The double arrow buttons move the selected text in 
bigger steps. 

The "Reset Text Position" button will restore the text to its original (before it was moved) position. 

Centring and Justifying Text 
The Positioning Tab Window has 8 types of centring and justifying controls.  These are: 

Left Justify 
Notice how all of the lines are lined up with the left margin. 

Right Justify 
Notice how all of the lines are lined up with the right margin. 

Horizontal Centreing 
Notice how all of the lines are centreed between the left and right margins. 

Justify to Left and Right Margins 
Notice how all of lines are lined up with both the left and right margins. 

Vertical Centreing 
The text is adjusted vertically to position it in the centre of the screen. 

Centre Horizontally and Vertically 
The text is adjusted horizontally and vertically to position it in the centre of the screen. 

Top Justify 
The text is adjusted vertically so that the top row is placed at the top margin. 

Bottom Justify 
The text is adjusted vertically so that the bottom row is placed at the bottom margin. 



59 

The "Row" section of the "Positioning Controls Window" (shown below) has four buttons.   

These buttons are used to control individual rows of text.  Each row can be 
centreed horizontally or justified to the left margin, right margin, or both margins 
at the same time. 

To centre a row, place the cursor on the row that you want to centre and press 
the "Horizontal Centreing" button.  The row is now centreed horizontally between 
the left and right margins. 

To justify the row to the right margin, press the "Right Justify" button in the "Row" 
section of the "Positioning Controls Window".  This moves the text to the right so that it is aligned to 
the right margin.  Press the "Left Justify" button in the "Row" section.  The text moves to the left so 
that it is aligned to the left margin. 

To justify the row to both margins at the same time, press the "Justify to Left and Right Margins" 
button in the "Row" section.  The first character of the row is placed at the left margin, and the spacing 
between the characters is adjusted so that the last character of the row is aligned to the right margin. 

To perform the centreing and justifying functions on all of the rows of text on the page (or on the 
layer), use the corresponding buttons in the "Layer/Page" section of the "Positioning Controls 
Window" (shown below).   

This section has two buttons (Layer and Page) to select whether 
each operation will be done on every row on the layer or every 
row on the page. 

Select the "Page" button to make the centreing and justifying 
functions work on every row of the page.  Try pressing the 
"Horizontal Centreing", "Right Justify", "Left Justify", and "Justify 
to Left and Right Margins" buttons in the "Layer/Page" section.   

Notice that the functions are now done to every row on the page. 

Press the "Centre Horizontal and Vertical" button (shown here) to centre the entire 
page (or layer) both horizontally and vertically. 

Press the "Top Justify" button (shown here) to move the entire page (or layer) to the 
top margin. 

Press the "Bottom Justify" button (shown here) to move the entire page (or layer) to 
the bottom margin. 

Press the "Vertical Centreing" button (shown here) to centre the page (or layer) 
vertically between the top and bottom margins. 
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Logos
As many as 16 different full colour logos can be placed on each page.  The logos can be loaded 
directly from GIF, TIF, TGA, BMP, PCX, JPG, or JPEG images.  If the image used as a logo has an 
alpha channel, the alpha channel is supported. 

To add a logo to a page, select the “Logos” tab in the Logos Controls Window.  The logo controls will 
be displayed as shown below. 

If the cursor is currently on a logo, information about that logo is displayed in this window.  The name 
of the image file that contains the logo is displayed.  This window also indicates the maximum size 
(height and width) that the logo can be displayed. 

Placing a Logo on the Page 
This window also has an "Add New Logo" button.  To add a new logo to the page, position the cursor 
where you want the logo to appear.  You may want to create a new layer for the logo, but you don't 
have to.  Press the " Add New Logo " button, and select the graphic image that you want to use as the 
logo.  The logo will then be displayed at the current character height.  Once a logo is added to a page 
you can size and edge it just like you would a character. 

Sizing a Logo 
The maximum size that a logo can be displayed on a page is 640 by 480 pixels or the original size of 
the logo (whichever is smaller).  If a graphic image was created at 100 scan lines high, it cannot be 
displayed larger than 100 scan lines. 

When a logo is first loaded it is displayed at the current character height.  The "Maximum Height" and 
"Maximum Width" entries in the Logo Control Window will be updated to indicate the maximum height 
and width that this logo can be displayed. 

To change the size of a logo, position the cursor on it, and then change the size of it just as if it was a 
character.  You can use the "Height" and "Width" controls in the "Character Controls Window” to vary 
the logos height and relative width.  You can also use the cursor handles to change the logos height 
and width. 
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Shapes
Shapes are boxes that you can control the roundness and the aspect ratio of.  Once the shape has 
been placed on the page you can size it, colourize it, add edges and shadows to it, and even rotate it.  
In fact you can do anything to a shape that you can do to a character (except change the typeface of 
it).  A “Foreground Shape” gets inserted into the current layer at the cursor position.  A “Background 
Shape” gets added to a new layer that is automatically created behind the text that is currently 
selected. 

To create or edit a shape select the "Shapes" tab in the "Control Tabs Window".  The shape controls 
window will be displayed as shown below. 

Aspect Ratio 
The “Aspect Ratio” of the shape can be changed from tall and skinny to very wide.  The aspect ratio 
can also be changed by changing the relative width (using the Character Width Controls).  The 
character width does have a limited range of 10% to 500%.  The aspect ratio controls are used to 
extend this range. 

Roundness
The “Roundness” of the shape can be set to any value from 0 to 100%.  A Roundness of 0% creates 
a shape that has square corners.  A Roundness of 100% creates the shape that is either a circle or an 
ellipse (depending on its aspect ratio).  A value between 1 and 99% creates a box that has rounded 
corners.  The amount that the corners are rounded is determined by the Roundness setting. 

Foreground Shapes 
Add a foreground shape by moving the cursor to the desired position and press the "Add Foreground 
Shape" button.  The new shape is inserted at the cursor position.  The shape is assigned the Current 
Character Attributes.  To increase the width of the shape using the aspect ratio controls, drag the 
aspect ratio slider to the right.  To decrease the width, drag this slider to the left.  Use the 
“Roundness” control to adjust the roundness of the shape.  Dragging the “Roundness” slider to the 
right will make the shape rounder; dragging it to the left will make it squarer. 

Now that the shape is on-screen you can use the "Character", "Edges", "Shadows", and "Colours" 
controls to modify the various character attributes of the shape.  The program creates the shape as if 
it were a character.  All of the controls that can be used to change the appearance of a character can 
be used to change the appearance of a shape. 

Background Shapes 
Enter the words "Background Shape" on the page.  Drag the mouse across all the characters of both 
words to select them.  Now press the "Add Background Shape" button.  A new shape is created 
behind the selected text.  A new layer was automatically created for this shape and placed behind the 
text. 
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This shape is exactly like the foreground shape except that it's on a separate layer.  You can change 
the character attributes just like you can a foreground shape or a character. 

Background Colour Boxes 
The Title Composer can display background colour boxes over the background image (or external 
video) and behind the text.  Each background colour box can be positioned and sized to anywhere on 
the screen.  The colour box can be set to a solid colour, a smooth colour spread between the top and 
bottom of the box, a colour gradient (a four or five point area gradient, or a linear gradient with up to 
16 colours), or a full colour texture.  If the background colour boxes have a solid colour, a colour 
spread, or a colour gradient, the transparency and background video levels of each colour point can 
be adjusted. 

As many as 32 background colour boxes can be used on each page.  Each background colour box is 
assigned to its own layer.  The background colour layers are always behind the text layers and in front 
of the background image.  The priority that each background colour box is assigned determines how 
they will appear when one background colour box overlaps another.  A background colour box that 
has a higher priority will appear in front of colour boxes that have lower priorities. 

 To create or edit a background colour box select the "Background-Colours" tab in the Control Tabs 
window.  The Background Colour Box Controls (shown below) will be displayed. 

Creating a New Background Colour Box 
To create a new background colour box press the "New Background Colour Box" button.  A new 
colour box will appear behind the cursor row.  The background colour box begins as a semi-
transparent gray that is the full width of the screen, and the height of the cursor row. 

The cursor appears to surround the new background colour box.  The cursor has six cursor handles.  
Three of these handles (on the left and bottom of the cursor) are used to position the colour box.  The 
other three handles (on the top and right of the cursor) are used to size the colour box. 

Moving and Sizing Background Colour Boxes 
Use the handle at the top of the cursor to adjust the height of the colour box.  Use the handle on the 
right side of the cursor to adjust the width of the colour box.  Dragging the handle on the upper right 
corner of the cursor will adjust both the height and width of the colour box. 

You can move the Background Colour Box in any direction by clicking on the handle in the lower left 
corner of the cursor and dragging the mouse.  If you want to move the colour box horizontally only 
(without moving it vertically) use the handle on the left side of the cursor.  The handle on the bottom of 
the cursor will move the colour box vertically (without changing the horizontal position). 
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Changing Background Colour Box Colour 
There are five different ways of selecting a colour for the background colour box.  These methods are 
as follows: 

Colour Picker 
The colour picker lets you select the colour using a visual approach. (see page 29 

Colour Sliders 
The colour sliders let you select a colour using a numerical approach. (see page 30) 

Colour Palette 
The colour palette lets you select a colour from a palette of 64 (User Definable) preset colours. (see 
page 30) 

Colour Gradient 
A colour can be selected from a group of 64 user-defined colour gradients.  These may be either a 
linear gradient with up to 16 colour points that can be rotated up to 90 degrees in either direction, or 
an area gradient that can have four or five colour points defined. (see page 31) 

Colour Texture 
A colour texture can be selected from any of the 16 textures that are currently loaded. 

Full-Screen Background Colour 
To create a background colour box that covers the full-screen, press the "Full Screen Background 
Colour" button.  A new background colour box (that is a semi transparent gray) will be created that 
covers the entire page. 

Selecting Background Colour Box 
You can only edit one background colour box at a time.  Before you can modify a background colour 
box you need to select it.  The selected colour box is displayed with a cursor (rectangular box) around 
it.  The cursor also has six small boxes attached to it.  These are called cursor handles, they are used 
to size and position the background colour box. 

Background colour boxes can be selected by clicking the mouse on the desired one.  If more than one 
background colour box overlap, keep clicking the left mouse button until the one you want is selected. 
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Changing Colour Box Priority 
Each colour background box is placed on its own separate layer (behind the text layers and in front of 
the background graphic image).  The priority of each background colour box determines how it will 
appear when one colour box is overlapped by another.  The background colour boxes that have a 
higher priority will appear in front of colour boxes that have a lower priority. 

The background colour controls have four buttons that are used to change the priority of the 
background colour boxes.  These buttons allow you to move the background colour boxes in front of, 
or behind other colour boxes when they overlap.  These buttons are shown below. 

Press this button to move the current background colour box to the highest 
priority.  When this is done it will appear in front of all other background colour 
boxes. 

Press this button to increase the priority of the current background colour box 
by one.  This will place the colour box in front of the colour box that had the next 
higher level of priority (if they overlap). 

Press this button to decrease the priority of the current background colour box 
by one.  This will place the colour box behind the colour box that had the next 
lower level of priority (if they overlap). 

Press this button to move the current background colour box to the lowest 
priority.  When this is done it will appear behind all of the other background 
colour of boxes. 

Converting a Background Colour Box to a Shape 
A background colour box can be converted to a shape by pressing the "Convert Colour Box to Shape" 
button.  When this is done the colour box is placed in front of all the other background colour boxes.  
Once a background colour box has been converted to a shape, it cannot be converted back to a 
Background Colour Box. 

When a background colour box is made into a shape, it can be italicized, rotated, and rounded just 
like any other shape.  It can also have edges and shadows added to it just like any other character. 

Deleting a Background Colour Box 
To remove a background colour box from the page, select the background colour box that you want to 
delete by positioning the mouse over it and clicking the left mouse button.  Once it is selected, press 
the "Delete Background Colour Box" button.  This will delete the current background colour box. 
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Background Images 
The program can display either a graphic image or a background video source (provided your system 
is capable of overlying titles over video) behind the text.  The background graphic can be in any of the 
following graphic formats: 

Windows bitmap (BMP) 
TIFF
Targa (TGA) 
PCX
GIF
JPG 
JPEG 

These are standard graphic formats that can be generated by many third party software packages.  If 
no background graphic image is selected, the text will be overlaid over the background video source 
(if your system is capable of this). 

A background graphic can be displayed in either original size, scaled to fill the entire screen, or tiled to 
fill the screen.  When the graphic is displayed with its original size, it may or may not fill the entire 
screen.  When a graphic is displayed full-screen, it is scaled (either up or down) to match the screen 
dimensions.  When the graphic is tiled, it is displayed in its original size and is repeated enough times 
to fill the entire screen. 

To change the background image, select the "Background - Image" tab In the Control Tabs window.  
The Background Image Controls (shown below) will be displayed. 

No Graphic (Background Video) 
Special hardware or software (if the program is running as a plug in) is required to overlay the titles 
over video.  Some systems are not capable of this.  If your system is not capable of overlaying titles 
over video, the background will be displayed as black. 

To overlay the title over background video, press the "No Graphic (Background Video)" button.  Any 
background graphic that may have been displayed will disappear and the text will be displayed over 
the background video. 
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Graphic - Original Size 
When you load a graphic to be displayed in its original size, the graphic may be smaller than the 
screen, the same size as the screen, or larger than the screen.  To load a graphic in its original size, 
press the "Graphic-Original Size" button.  A window will appear asking you to select the Background 
Graphic.  Select the graphic image that you want to load as a background and press the "Open" 
button.  The selected graphic will be loaded. 

If the graphic is smaller than the screen, it will be centreed on the screen, and the positioning buttons 
that are used to change graphic position will be displayed. 

If the graphic is the same size as the screen, it will be displayed as a full-screen image.  If the graphic 
is larger than screen, a warning message (like the one shown below) will appear. 

At this point you have the option of shrinking the graphic so that the entire image will fit on the screen, 
or displaying the graphic in its original size and cutting off the outside edges of the graphic.  To 
display the graphic without shrinking it, press the "No" button.  The new graphic will then loaded as 
the background. 

To shrink the background graphic so that all of it will be displayed, press the "Yes" button.  This will 
load the graphic "Full-Screen".  See the section below (Graphic-Full Screen) for more information. 

Graphic - Full Screen 
When you load a graphic to be displayed full-screen, and the original size of the graphic is not the 
same as screen dimensions, the graphic must be scaled before it will fit the screen.  If the graphic is 
smaller than the screen, it will be enlarged.  If the graphic is larger than the screen, it will be reduced 
in size. 

A video screen has a fixed aspect ratio of 4 by 3 (or 16 by 9).  This means that the screen wider than 
it is tall.  If the background graphic image has a different aspect ratio (maybe it's taller than it is wide), 
the height and the width will need to be scaled by different amounts to make the image fill the entire 
screen.  This can distort the image.  It can make people look very fat, or very tall. 
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Before the background image is loaded full-screen the aspect ratio of the graphic is checked to see if 
it matches the screens aspect ratio.  If the aspect ratios are different, a warning message (like the one 
shown below) is displayed. 

If you choose to preserve the aspect ratio, the background graphic will be scaled horizontally and 
vertically by the same amount.  This will prevent the image from being distorted.  However the graphic 
will not fill the screen both horizontally and vertically. If the image is too tall, it will not fill the screen 
horizontally.  If the image is too wide, it will not fill the screen vertically. 

If you choose not to preserve the aspect ratio, the background image will be scaled horizontally and 
vertically the amount necessary to fill the entire screen.  If this results in unacceptable distortion, 
simply load the background graphic again.  This time preserve the aspect ratio. 

Graphic - Tiled 
If a graphic image is smaller than the screen, it can be tiled in the background.  This will display the 
background graphic in its original size.  The graphic will be repeated horizontally and vertically to fill 
the entire screen. 

To tile a background graphic, press the "Graphic - Tiled" button. A window will appear asking you to 
select the background graphic.  Select the graphic image that you want to load as a background and 
press the "Open" button.  The selected graphic will be loaded and tiled. 

If the graphic is larger than the screen, a warning message (like the one shown below) will appear. 

At this point you have the option of shrinking the graphic so that the entire image will fit on the screen, 
or displaying the graphic in its original size and cutting off the outside edges of the graphic.  To 
display the graphic without shrinking it, press the "No" button.  The graphic will then be loaded as the 
background.  Portions of the graphic image will be cut off. 
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Creating a New Project 
When a new project is created, the current systems settings are saved as the new project defaults.  
So, before you create a new project, you should open an existing project that has system settings 
similar to the default system settings that you want the new project to have. 

To create a new project, select the "New Project" command from the "File" or “Project Manager” 
menu's.  When this is done a window (like the one shown below) is displayed. 

Enter the name of the new project where it says "New Project Name" and press the "Create" button.  
The name of the new project now appears at the top of the project manager.  Since we haven't 
created any pages for the new project yet, no pages appear in the list.  As you create pages for this 
new project they will appear in the Project Manager window. 

Open an Existing Project 
To open a project that already exists, select the "Open Project" command from the "File" or Project 
Manager menus.  Once this is done the "Load New Project Settings" window (shown below) will 
appear. 

Use this window to select which project to open and press the "Open" button.  When the new project 
is opened, the new project’s system settings will be loaded.  The old project settings will be 
overwritten.
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Before the old project settings are lost, you may be given the chance to save them (if the User 
Preferences are set accordingly).  If so the following window will appear. 

You can save the old system settings to the old project file by pressing the "Yes" button.  Pressing the 
"No" button will open the new project without saving the system settings. 

Once the new project is opened, the pages in the project will appear in the Project Manager window. 

Save Project Settings 
To save the current settings as the project defaults, select the “Save Project Settings” command from 
the “File” or Project Manager menus.  The current project settings will be saved to the Settings (.SET) 
file so that they can be restored the next time this project is opened. 

Pages
When pages are saved on the disk, they are each saved in a separate file.  The sizes of these files 
are determined by the amount of text and the complexity of the page.  Most pages are smaller than 1 
or 2 Kbytes unless they contain logos or textures.  Hundreds of pages can be stored on a floppy disk 
and millions can be stored on a hard drive.  Each page file can be given a unique name.  The “.PAG” 
extension is added to the page name to create the file name that the page will be stored under. 

The pages are stored in a format that allows them to be fully edited, even after they are saved.  You 
don’t need to worry about things getting “locked down” after the page has been saved.  The pages 
can also be saved in both Windows Bitmap (BMP) and Targa (TGA) formats.  This lets you use the 
Title Graphics that you create in other graphics programs.  Saving the page as one of these graphics 
formats automatically saves it in the Page (PAG) format as well.  This keeps the page in a format that 
can still be edited (Have you ever tried to correct the spelling of a word in a Bitmap?). 

All information needed to display the page is stored in the page file except for the Typefaces and the 
background graphic.  When a page has a Logo or multiple Logos on it, the logo is stored in the page 
file.  This is done to speed up the Page Recall time.  The page file does keep track of which 
background graphic and typefaces are used in the page.  When a page is recalled, the system will 
automatically load the needed typefaces and the background image. 

When a page is saved or recalled, the dialog box first displays with the default page directory.  You 
can select another directory to save the page to or recall it from. 

The default page directory can be changed.  See the section “Default Directories” for more information 
on how to do this. 

Creating a New Page 
Please Note:  Some systems may not support rolls and crawls. If your system does not, the 
appropriate menu entries will not be displayed in the menu. 

To create a new page, use one of the following commands: 
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Press the “New Page” button on the Toolbar. 
Select the “New Page” entry from the “File” menu. 
Select the  “New Still Page” entry from the “File” menu. 
Select the “New Roll Page” entry from the “File” menu. 
Select the “New Crawl Page” entry from the “File” menu. 
Press and hold down the <Ctrl> key while pressing the <N> key. 

When this is done the process of creating a new page will begin.  If the “Automatically Save Pages” 
setting in the “User Preferences” dialog box requires it, the following message box will appear. 

The system can only have one page opened at a time.  When you open a new page, the old page (or 
any changes made to it) will be discarded unless it is saved to the disk.  If you want to save the 
changes to the old, page press <Yes>, otherwise press <No> and the changes will be discarded. 

If the page was not saved, the following warning will appear: 

If you do not want to lose the changes to the current page, press the “No” button to cancel the New 
Page operation.  You can then save the old page. 
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If you press the “Yes” button, all of the text and background will be erased from the screen.  If you did 
not use a command that specified the page type, the “Select the Page Type” dialog box (shown 
below) will appear.   

Select the Page type dialog box 

Some systems may not support rolls and crawls.  If your system does not, the appropriate buttons will 
be disabled.  Use this box to select which type of page you want to create.  This gives you a fresh 
page to start with. 

Opening an Existing Page 
Opening a new page will overwrite the page that is currently open.  Make sure that you save any 
changes to the current page that you want to keep before opening a new one. 

To open an existing page, use one of the following commands: 

Select it from the listed pages in the Project Manager window. 
Select the “Open Page” entry from the “File” menu. 
Press the “Open Page” button in the Toolbar. 
Press and hold down the <Ctrl> key while pressing the <O> key. 

If the “Automatically Save Pages” setting in the “User Preferences” dialog box requires it, the following 
message box will appear. 
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The system can only have one page opened at a time.  When you open a new page, the old page (or 
any changes made to it) will be discarded unless it is saved to the disk.  If you want to save the 
changes to the old page press “Yes”, otherwise press “No” and the changes will be discarded. 

Once this is done the Open Page dialog box (shown below) will appear. 

Open Page dialog box 

Use this dialog box to select which page to open.  Once a page is opened it will appear in the “Title 
Compose” window.  You can now edit the page. 

Saving a Page 
When you are finished editing a page, you need to save it to the disk.  To do this, select the “Save 
Page” entry from the “File” menu (or press the “Save Page” button on the Toolbar).  If the page 
already has a name, it will be saved back to the disk under the old name.  If the page does not yet 
have a name, the Save Page As dialog box will appear (see Saving a Page with a New Name) so that 
you can name the page. 

It is a good idea that while editing a page you should save it to disk.  This protects your work from 
things like power failures.  This function can be accomplished by holding down the <Ctrl> key and 
pressing <S>. 
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Saving a Page with a New Name 
To save a page with a new page name, select the “Save Page As” entry from the “File” menu.   

When this is done, the Save Page As dialog box (shown below) will appear. 

Save Page As dialog box 

Use this dialog box to select a name for the page.  The “Save as type” control allows you to select 
which format you would like to save the page as.  This can be any of the following: 

Page (*.PAG) 
Windows Bitmap (*.BMP) 
Targa format (*.TGA) 

Some systems may also have other formats to choose from. 

If you save the page as either a Windows Bitmap or Targa format file other graphics programs can 
use the image.  Since text stored in these formats cannot be edited (without a great deal of difficulty), 
the page will also be saved in the “Page (*.PAG)” format.  This keeps the page in a format that you 
can edit. 

If the page is saved under a new name, the old page will remain on the disk under the old page name. 

Deleting a Page from the Disk 
Before you can delete a page from the disk you must use the Open Page function to recall the page 
to the screen.  This forces you to “look at it” to make sure it’s the right page before you delete it.  Once 
the page has been opened, select the “Delete Page” entry from the “File” menu.  A warning such as 
the one below will appear. 
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The second line in the warning box shows the directory and page name of the page about to be 
deleted.  If you don’t want to delete this page, press the “No” Button.  Pressing the “Yes” button will 
delete the page from the disk.  Once this is done you will not be able to open the page again. 

Export Page 
Many systems need to have the title pages exported in a particular graphics format.  In most 
instances this is the Targa (TGA) format (although some systems require a Proprietary format).  The 
file format of the exported Title Graphics can be set using the “User Preferences”. 

The Title Graphic can also be exported to the Windows Clipboard.  When a Title Graphic has been 
exported to the clipboard, other graphic programs can used it by using the “Paste” function. 

To export a page, press the "Export Page" button in the shortcut buttons window.  The page must be 
named before it can be exported.  If the page is not named, a message (like the one below) will 
appear to remind you to give the page a name.  Once the page is named, you can then export it.  The 
exported image will have the same name as the page you are exporting (except with a different file 
extension).  For example: if the page were export in Targa (TGA) format under the name 
"TITLE.PAG", the image file would be saved as "TITLE.TGA". 

If you press the “OK” button the “Save Page As” dialog box will appear to allow you to give the page a 
name. 

The page can also be exported by selecting the "Export Title Graphic" command from the "File" or 
"Project Manager" menus. 
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Page Transitions 
When pages are shown ON AIR, each page can be displayed with some sort of page transition.  
There are a number of different Page Transition Types to choose from.  You can control how long the 
Page Transition takes by setting the Transition Duration.  Each page can be set to different Transition 
Type, Transition Duration, and Dwell Duration.  This lets you inter-mix different transition types and 
durations in a sequence of pages.  For example: one page can roll onto the screen fast, and the next 
page can wipe on slowly.   

These three page attributes (Transition Type, Transition Duration, and Dwell Duration) are saved with 
the page.  Be sure to set these page attributes before saving the page. 

Not all Transition Types are available in all systems.  Some Transitions require capabilities that are 
not available in all display cards.  The Page Transition Type drop down box will display the Page 
transitions that are available on your system. 

To set the Page Attributes, select the “Page Transitions” tab in the Control Tabs Window.  The 
controls for setting the Page Attributes will then be displayed as shown below. 

Page Transition Type 
There are different categories of page transitions for the program.  Some categories have only 1 
transition type (such as Cut).  While other categories have many transition types (such as block 
transition with 57 types).   

The Page Transition Type drop down box displays the current transition type.  It is used to select the 
new transition type.  The drop down box lists every category of transition type available.  If there is 
only one transition type in a category, the name of the transition is listed.  Selecting this from the list 
will select this as the transition type.  If there are multiple transition types in the category, the name is 
followed by 3 dots (...).  Selecting this from the list will display another window so that you can be 
more specific about which transition type you want to select. 

Once a Page Transition type is selected, it will appear in the Page Transition Type box.  For a 
detailed description of each Page Transition type, see the section Transition Types.  
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Transition Duration 
The Transition Duration specifies how much time it takes to perform the page transition.  This controls 
how fast the page displays when the page is displayed ON AIR.  The duration is specified in frames.  
In NTSC a frame is 1/30 of a second.  In PAL a frame is 1/25 of a second. 

To change the Transition duration, select the Transition Duration box (using either the keyboard or the 
mouse) and enter the new value. 

Dwell Duration 
The Dwell Duration specifies how long the page will remain on the screen when automatically 
sequencing pages.  The duration is specified in seconds.  To change the Dwell duration, select the 
Dwell Duration box (using either the keyboard or the mouse) and enter the new value.  This value is 
ignored when manually controlling pages. 

Transition Types 
The categories and the number of transition types they contain are listed below: 

Category 
Number of 
Transition Types 

  1-Cut   1 
  2-Crawl   1 
  3-Roll   1 
  4-Wipe   8 
  5-Block 57 
  6-Iris 18 
  7-Sparkle   1 

The following is a brief description of each transition type in each category. 

Cut
When a page is shown with a Cut transition type it comes on immediately (all at once).  With a Cut 
transition type the Transition Duration is meaningless. 

Crawl 
When a page is displayed with a Crawl transition type, it moves from right to left across the screen at 
a speed required to show all of the text in the time specified by the Transition Duration.  For more 
information about Roll & Crawl speeds, see the section titled “Roll and Crawl Speeds” below. 

Since a crawl is one long row, every row except the top one will disappear.  You will not be able to 
move the cursor off of this row.  The crawl row is always the top row of the page.  If you want the 
crawl to appear in a different position on the screen, use one of the following commands to change 
the row position: 

Move the row by selecting the “Fine Position Text...” entry from the “Positioning” Control tab. 
Justify the page to the bottom margin by pressing the “Bottom Justify” entry from the “Positioning” 
control tab. 
Set the Lower Third Mode by selecting the “Lower Third Mode” entry from the “Settings” menu. 

After the Page transition type has been set to Crawl, the system enters the crawl compose mode.  In 
this mode, moving the cursor beyond the right margin will scroll the row to the left.  Moving the cursor 
beyond the left margin will scroll the row to the right. 

Credit Roll (variable length) 
A credit roll page rolls onto the screen starting from the bottom.  The page moves up the screen at the 
speed required to show all of the text in the time specified by the Transition Duration.  The top of the 
page disappears off the top of the screen as the rest of the page appears on the bottom of the screen. 
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A Credit Roll can be up to 1000 rows long.  Of course, that many rows can’t appear on the screen at 
one time.  When composing a credit roll, if you move the cursor below the bottom margin, the page 
will scroll up to expose more of the roll text.  If you try to move the cursor above the top margin, the 
page will scroll down. 

Interlacing issues with crawls and scrolls 
If the crawling or scrolling characters look stepped or jerky when playing back this can be easily fixed 
by checking "Reverse Fields" in CG-350’s "Hardware Settings" window. See User Preferences on 
page 83. 

Roll and Crawl Speeds 
Because of the interlaced nature of video, only certain roll and crawl speeds will appear smooth.  For 
a Roll or Crawl to show in the time specified by the Transition Duration, the required speed could be 
jerky.  To solve this problem, the roll and crawl will start at the next slower speed that is smooth.  As it 
displays at the slower speed it will get behind.  It will continue to run at the slower speed until it is far 
enough behind that running at the next faster speed (that is smooth) will make it end at the right time.

User Preferences 
The "User Preferences" window is used to set preferences that may vary from one user to another.  
To change the user preferences select the "User Preferences" command from the "Settings" menu.  
When this is done the "User Preferences" window (such as the one shown below) will appear. 

The “User Preferences” window is used to set the following User Preferences. 

Graphic Image Transition Select the Transition that will be used for Graphic Images. 

Automatic Program Start Automatically runs the program when windows starts. 

Automatic Sequence Restart Automatically restart sequence after a power failure. 
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Animation Buffer Size Size of Memory Buffer for Animations and Video Clips. 

Automatically Save Display List Selects the Automatic Display List Save mode. 

Video Format Settings Selects the Video Format. 

Graphic Image Transition 
When images are displayed, each image can be displayed with some sort of transition.  There are a 
number of different Transition Types to choose from.  You can control how long the Transition takes 
by setting the Transition Duration.  Each image can be set to a different Transition Type, Transition 
Duration, and Dwell Duration.  

When a title page is created, the user selects the Transition Type, Transition Duration (speed), and 
the Dwell Duration.  Standard graphic images don’t have this information stored with them.  The 
controls in the “Graphic Image Transition” section of the User Preference Window are used to select 
these parameters for graphic images. 

Some Transition Types may be un-available.  Some Transitions require capabilities that may be un-
available within your chosen display card.  The Transition Type drop down box will display the 
transitions that are available on your card. 

Transition Type 
There are different categories of transitions for the program.  Some categories have only 1 transition 
type (such as Cut).  While other categories have many transition types (such as block transition with 
57 types).   

The Transition Type drop down box displays the current transition type.  It is used to select the new 
transition type.  The drop down box lists every category of transition type available on your system.  If 
there is only one transition type in a category, the name of the transition is listed.  Selecting this from 
the list will select this as the transition type.  If there are multiple transition types in the category, the 
name is followed by 3 dots (...).  Selecting one of these from the list will display another window so 
that you can be more specific about which transition type you want to select. 

Once a Transition Type is selected, it will appear in the Transition Type box.  For a detailed 
description of each Transition Type, see the section “Transition Types” later in this chapter. 

Transition Duration 
The Transition Duration specifies how much time it takes to perform the transition.  This controls how 
fast the image appears when it is displayed.  The duration is specified in frames.  In NTSC a frame is 
1/30 of a second.  In PAL a frame is 1/25 of a second. 

To change the Transition duration, select the Transition Duration box and enter the new value. 

Dwell Duration 
The Dwell Duration specifies how long the image will remain on the screen when automatically 
sequencing images. The duration is specified in seconds.  To change the Dwell duration, select the 
Dwell Duration box and enter the new value.  This value is ignored when manually controlling pages. 
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Transition Types 
The categories and the number of transition types they contain are listed below: 

Category 
Number of 
Transition Types 

Cut 1 
Wipe 8 
Block 57 
Iris 18 
Sparkle 1 

The following is a brief description of each transition type in each category. 

Cut 
When an image is shown with a Cut transition type it comes on immediately (all at once).  With a Cut 
transition type the Transition Duration is meaningless. 

Wipes
When “Wipes...” is selected from the Transition Type control, the “Wipe Transitions” window (shown 
below) will appear. 

This window shows the various wipe transitions. 
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There are 8 different types of Wipe Transitions.  These are: 

Wipe from Top to Bottom 
The new image begins to appear at the top of the screen and wipes down toward the bottom of the 
screen.  The new image covers the old image. 

Wipe from Bottom to Top 
The new image begins to appear at the bottom of the screen and wipes up towards the top of the 
screen.  The new image covers the old image. 

Wipe from Left to Right 
The new image begins to appear at the left side of the screen and wipes towards the right side of the 
screen.  The new image covers the old image. 

Wipe from Right to Left 
The new image begins to appear at the right side of the screen and wipes towards the left side of the 
screen.  The new image covers the old image. 

Wipe In from Top & Bottom 
The new image begins to appear at both the top and bottom of the screen and wipes in towards the 
centre of the screen.  The new image covers the old image. 

Wipe Out from Top & Bottom 
The new image begins to appear at the centre of the screen and simultaneously wipes up and down 
towards the top and bottom of the screen.  The new image covers the old image. 

Wipe In from the Sides 
The new image begins to appear at both the left and right sides of the screen and wipes in towards 
the centre of the screen.  The new image covers the old image. 

Wipe Out to the Sides 
The new image begins to appear at the centre of the screen and simultaneously wipes both left and 
right towards both sides of the screen.  The new image covers the old image. 

Select the desired wipe transition and the type of wipe that is selected will appear in the Image 
Transition Type drop down box. 



81 

Block Transitions 
When “Block...” is selected from the Image Transition Type control, the “Block Transitions” window 
(shown below) will appear: 

This window lets you select the various Block Transitions.  There are a total of 19 different types of 
block transitions, and 3 different sizes of blocks, for a total of 57 different Block display types:  The 
basic block transition types are: 

Random
The blocks that make up the new image come onto the screen randomly in small rectangles that 
cover the old image.  Select this transition type by selecting the “Random” button in the “Reveal Type” 
group. 

Spiral In 
The blocks that make up the new image start to appear at the upper left corner.  These blocks are 
added to the screen in a Spiral In pattern towards the centre of the screen in a clockwise direction.  
Select this transition type by selecting the “Spiral In” button in the “Block Direction” group. 

Spiral Out 
The blocks that make up the new image start to appear in the centre of the screen.  These blocks are 
added to the screen in a Spiral Out pattern towards the edges of the screen in a clockwise direction.  
Select this transition type by selecting the “Spiral Out” button in the “Block Direction” group. 
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Scan
The blocks that make up the new image start to appear at the position specified by the Block 
Direction.  The blocks scan across the screen.  When the other end of the screen is reached, the next 
row of blocks is drawn in the same direction as the previous row of blocks.  Select this transition type 
by selecting the “Scan” button in the “Reveal Type” group.  Select the starting point and scan direction 
from the “Block Direction” group. The starting points to choose from are: 

From Upper Left Corner 
The blocks start to appear in the upper left corner of the screen.  Each row of blocks scans left to 
right/ bottom to top.  This continues until the blocks fill in to the Lower Right corner. 

From Top to Bottom 
The first row of blocks appears at the top of the screen.  Each row of blocks scans left to right.  This 
continues until the blocks fill in to the bottom of the screen. 

From Upper Right Corner 
The blocks start to appear in the upper right corner of the screen.  Each row of blocks scans left to 
right/top to bottom.  This continues until the blocks fill in to the Lower Left corner. 

From Left to Right 
The first row of blocks appears at the left side of the screen.  Each row of blocks scan top to bottom.  
This continues until the blocks fill in to the right side of the screen. 

From Right to Left 
The first row of blocks appears at the right side of the screen.  Each row of blocks scan top to bottom.  
This continues until the blocks fill in to the left side of the screen. 

From Lower Left Corner 
The blocks start to appear in the lower left corner of the screen.  Each row of blocks scans left to 
right/top to bottom.  This continues until the blocks fill in to the Upper Right corner. 

From Bottom to Top 
The first row of blocks appears at the bottom of the screen.  Each row of blocks scans left to right.  
This continues until the blocks fill in to the top of the screen. 

From Lower Right Corner 
The blocks start to appear in the lower right corner of the screen.  Each row of blocks scans left to 
right/top to bottom.  This continues until the blocks fill in to the Upper Left corner. 

ZigZag 
These transition types are similar to the Block Scan transition types.  The main difference is, each row 
of blocks appears in a zigzag pattern.  When a row of blocks are drawn, the next row of blocks are 
drawn in the opposite direction.  Select this transition type by selecting the “Zig Zag” button in the 
“Reveal Type” group.  Select the starting point and scan direction from the “Block Direction” group. 
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Transition Block Sizes 
The user can choose between three sizes of the blocks that make up the new image.  These are: 

Small 
The screen is broken up into 4332 blocks. 76 blocks horizontally by 57 blocks vertically. 

Medium
The screen is broken up into 972 blocks, 36 blocks horizontally by 27 blocks vertically. 

Large 
The screen is broken up into 300 blocks, 20 blocks horizontally by 15 blocks vertically. 

The size of the block does not affect the Transition Duration.  The smaller blocks are just displayed at 
a higher rate than the larger blocks.  Select the block size from the “Block Size” group of buttons. 

Select the desired block transition and the selected Block Transition type will appear in the Transition 
Type box. 

Iris Transitions 
When “Iris...” is selected from the Transition Type control, the Iris Transitions window (shown below) 
will appear. 

This window lets you select the various iris transitions.  To select an Iris Transition, select “Open” or 
“Close” from the “Iris” group, and select the position from the “Iris Position” Group.  Once selected, the 
selected Iris Transition will appear in the Transition Type drop down box.  There are a total of 18 Iris 
Transitions, 9 Open and 9 Close. 

When an image is displayed with an “Iris Open” transition, a rectangular iris appears at the Iris 
Position.  This iris opens to display the new image.  With an “Iris Close” transition, a rectangular iris 
appears around the entire old image and closes towards the Iris Position.  This makes the old image 
disappear and uncovers the new image. 

Each Iris transition can happen at any of 9 positions on the screen.  
These positions are described on the next page: 



84 

Upper Left 
Corner 

Open A rectangular iris appears in the Upper Left Corner of the screen 
and opens up to display the new page. 

Close A rectangular iris appears around the old page and closes towards 
the Upper Left Corner of the screen.  As the iris closes, the old 
page disappears and uncovers the new page. 

Top of Screen Open A rectangular iris appears in the middle of the top of the screen and 
opens up to display the new page. 

Close A rectangular iris appears around the old page and closes towards 
the middle of the top of the screen.  As the iris closes, the old page 
disappears and uncovers the new page. 

Upper Right 
Corner 

Open A rectangular iris appears in the Upper Right Corner of the screen 
and opens up to display the new page. 

Close A rectangular iris appears around the old page and closes towards 
the Upper Right Corner of the screen.  As the iris closes, the old 
page disappears and uncovers the new page. 

Left of Screen Open A rectangular iris appears in the middle of the left side of the 
screen and opens up to display the new page. 

Close A rectangular iris appears around the old page and closes towards 
the middle of the left side of the screen.  As the iris closes, the old 
page disappears and uncovers the new page. 

Centre of 
Screen 

Open A rectangular iris appears in the centre of the screen and opens up 
to display the new page. 

Close A rectangular iris appears around the old page and closes towards 
the centre of the left side of the screen.  As the iris closes, the old 
page disappears and uncovers the new page. 

Right of Screen Open A rectangular iris appears in the middle of the right side of the 
screen and opens up to display the new page. 

Close A rectangular iris appears around the old page and closes towards 
the middle of the right side of the screen.  As the iris closes, the old 
page disappears and uncovers the new page. 

Lower left 
Corner 

Open A rectangular iris appears in the Lower Left Corner of the screen 
and opens up to display the new page. 

Close A rectangular iris appears around the old page and closes towards 
the Lower Left Corner of the screen.  As the iris closes, the old 
page disappears and uncovers the new page. 

Bottom of 
Screen 

Open A rectangular iris appears in the middle of the bottom of the screen 
and opens up to display the new page. 

Close A rectangular iris appears around the old page and closes towards 
the middle of the bottom of the screen.  As the iris closes, the old 
page disappears and uncovers the new page. 

Lower Right 
Corner 

Open A rectangular iris appears in the Lower Right Corner of the screen 
and opens up to display the new page. 

Close A rectangular iris appears around the old page and closes towards 
the Lower Right Corner of the screen.  As the iris closes, the old 
page disappears and uncovers the new page. 

Sparkle
When an image is displayed with a sparkle, each scan line of the new image appears in a random 
order.  Each new scan line replaces a scan line of the old image. 
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Automatic Program Start 
When the “Automatically Start Program during System Startup” button is checked, the program will be 
automatically started whenever Windows starts. 

Automatic Sequence Restart 
Sometimes when the program is automatically sequencing, the system many restart because of a 
power failure.  If the “Automatically Restart Sequencing after power interruption” button is checked, 
the program will restart the sequence the next time that the program runs.  You must still check the 
“Automatically Start Program during System Startup” button to automatically run the program after a 
power failure. 

Animation Buffer Size 
Playing Text FX Animations or Video Clips requires large amounts of data every second.  Since most 
disk drives can’t deliver data fast enough, the program needs to load the data into a buffer before it 
begins displaying it.  A larger buffer can playback longer Animations and Video Clips, but it also uses 
more of your systems RAM.  Use this control to select how much of your systems memory you want 
to use for this buffer. 

Automatically Save Display Lists 
The program can only have one Display List open at a time.  When you open a new one, the old 
Display List (or any changes made to it) will be discarded unless it is saved to disk.  When you open a 
new Display List, or exit the program, the current Display List can automatically be saved to the disk if 
it was changed. 

Always Automatically Save 
This setting will automatically save the Display List to disk (overwriting the original) without prompting 
you.  Use this setting with caution.  Any changes that you make to the Display List will be saved to 
disk.  You won’t have the option of discarding the changes. 

Always Ask First 
This setting will ask your permission before saving the Display List to disk.  If you have not modified 
the Display List, you will not be asked if you want to save it. 

Never Automatically Save 
This setting will never automatically save the Display List.  All changes to the current Display List that 
haven’t previously been saved will be discarded when you open a new Display List or exit the 
program. 
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Video Format Settings 
The values in “Video Format Settings” indicate the display resolution that the program is currently 
configured for.  Some Display Cards control the Video Format; other cards expect the program to 
determine the Video Format.  If the Display Card that you are using is one that controls the Video 
Format, a button labelled “Hardware Settings” will replace the “Change Video Format” button in this 
section.  The “Hardware Settings” button will be described later in this chapter.  Pressing the “Change 
Video Format” button will display the “Select Video Format” window (shown below).  This window can 
also be displayed by selecting the “Change Video Format” entry from the “Settings” menu. 

This window lists the standard Video Formats.  With CG-350 the “HDTV” selections will be enabled 
with an appropriate display card fitted to the computer.  When a standard Video Format is selected, 
the program configures itself with the required display resolution and pixel aspect ratio (square or 
rectangular).  If none of the standard formats suit your needs, you can select a “Custom” format.  
When this button is checked you can enter the desired display resolution.  The “Custom” format will 
only create square pixels. Please note some display cards and monitors do not support Custom 
formats. 

The program must be restarted before the Video Format changes will take effect.  You will be 
reminded of this by displaying the “Video Format Changed” Window (shown below).  Press “Yes” if 
you are sure you want to restart the program. It is always advisable to save any changes to your 
current project before changing the Video Format. 
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Display Card Hardware Settings 
Each Display Card must have a Display Driver designed especially to interface the Display Card to 
the computer and software.   

Each different Display Card has is own unique method of changing Hardware Settings.   

We will give an overview of four Display Drivers that are representative of various methods used to 
change the Hardware Settings. 

The four Display Card drivers to be discussed will be: 

Blackmagic Design’s DeckLink cards (SD and HD) 
AJA’s Xena Card (SD and HD) 
VGA/Scan Converter 
Multiple VGA adapters using DirectX 
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Blackmagic Design DeckLink Cards 
We have found the following 3 DeckLink cards to be compatible with most end users output display 
requirements at SD and HD resolutions. If you want to try a different type of display card please 
consult your dealer or local Datavideo office for advice first. 

Please remember that DeckLink cards only support broadcast safe resolutions and custom 
resolutions set within the CG-350 software may not be supported by these cards. 

DeckLink HD Extreme II or III requires PCI Express slot Driver version 6.8.3 or above 

DeckLink Studio  requires PCI Express slot Driver version 6.8.7 
DeckLink SDI   requires PCI Express slot Driver version 6.8.7 

Once the driver is installed go to the Windows start menu and select control panel and then DeckLink. 
Various options are then available from the DeckLink screen. 

For more information on these cards or to download the latest PDFs and drivers please visit 
www.blackmagic-design.com/support 
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AJA Xena Cards 
The AJA Xena card is manufactured by AJA Video. Both Standard Definition and High Definition 
versions of this card are available.  A system may have one of each installed.  These cards have 
Serial Digital Inputs and Outputs as well as a Sync Reference input (1v and 4V).  Its Hardware 
Settings window appears as below: 

AJA Xena Card Hardware Settings Window. 

The “Video Output Format” section is used to select the Video Output Format (obviously).  The 
Standard Def and Hi Def buttons are used to select which Display Card to use.  If either card is not 
installed, the button for it will be disabled.  When a card is selected, the formats that the selected card 
supports will be placed in the drop down box.  The current format will appear.  To select a different 
format, just select it from this list. 

Each card has two (2) Video Inputs and 1 Reference Input.  The Video format of each of the incoming 
signal is displayed in the Video Inputs Section.  The “Background Video” control has the following 
selections: Input 1, Input 2 and Black. 

Use this to select the video that you want to title over. 

The Reference control lists the inputs that can be used to synchronize the Video Output to the rest of 
the facility.  It has the following selections: 

Input 1 - Synchronizes to the Video Signal on Video Input 1 
Input 2 - Synchronizes to the Video Signal on Video Input 2 
Free Run - Does not synchronize to any signal. 
Reference (1.0 Volt) - Synchronizes to the 1 Volt signal on the Video Reference Input. 
Reference (4.0 Volt) - Synchronizes to the 4 Volt signal on the Video Reference Input. 

Video Timing controls are used to adjust the Horizontal and Video Timing of the output in relation to 
the selected Reference input. 

Each card can have multiple Profiles.  A Profile is a group of settings that may change from one 
configuration to the next.  You can create as many Profiles as you want.  When you select a profile, 
the settings are automatically changed to the settings that were assigned to the profile. 
For more information on AJA cards visit www.aja.com  
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VGA/Scan Converter 
The program will run with just a normal VGA card.  However to get NTSC/PAL video out of it you will 
need to use either a VGA card with an NTSC/PAL output, or use a scan converter that will convert the 
VGA video to NTSC/PAL video.  When using the Display Driver for the VGA card, the Hardware 
Settings window appears as below: 

VGA Card Hardware Settings Window. 

This window shows where the Video output will be displayed on the output.  It can be sized and 
positioned using this window.  If you have multiple Video screens, you can even move it to one of the 
other screens.  Normally this should cover the entire screen, but in some cases you may want to have 
the Video Output appear at a certain position on the screen.  Be aware that when you are displaying 
pages, this may cover your User Interface if it is on the main screen. 

This window can be moved by dragging the Title Bar around the screen or by changing the” Top” and 
“Left” values.  Dragging the edges of the windows will change the size of the window.  Changing the 
“Width” and “Height” values can also change the window size.  The Window can be sized to full 
screen by checking the “Maximize Window” button. 
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Multiple VGA adapters using DirectX 
If you have multiple VGA screens, and DirectX version 6.0 or later installed on your system, you will 
probably get better performance using this Display Driver than the VGA/Scan Converter driver.  
However to get NTSC/PAL video out of it you will need to use either a VGA card with an NTSC/PAL 
output, or use a scan converter that will convert the VGA video to NTSC/PAL video.  When using the 
Display Driver for the Multiple VGA cards, the Hardware Settings window appears as below: 

Multiple VGA Card (DirectX) Hardware Settings Window. 

The “Display Devices” drop down box lists all of the DirectX compatible Display Adapters that are 
installed on your system.  Your main VGA screen has two listings in the drop down box.  The “Primary 
Display Driver” and the actual name of the card that is used by the Primary Display.  If you use either 
one of these as your Display Device, it will cover your user interface while you are displaying pages. 

Once the Display Device is selected, the “Display Modes” list displays the Display Modes that are 
available with the selected Display Device.  Select the Display mode that you want and press OK.  
The program will then adapt itself to the new settings. 



92 

Service and Support 
It is our goal to make your products ownership a satisfying experience. Our support staff are available 
to assist you in setting up and operating this product. Please refer to our web site www.datavideo-
tek.com for answers to common questions, support requests or contact your local Datavideo office 
below. 

Datavideo Corporation (USA) 
7048 Elmer Avenue. Whittier, CA 90602 USA 
Tel: +1 562 696 2324  contactus@datavideo.us www.datavideo.us 

Datavideo Technologies Europe BV 
Floridadreef 106, 3565 AM Utrecht, The Netherlands  
Tel: +31 30 261 9656  info@datavideo.nl  www.datavideo.info 

Datavideo UK Limited 
Unit 2 Waterside Business Park, Hadfield, Glossop, Derbyshire SK13 1BE UK 
Tel: +44 1457 851000  sales@datavideo.co.uk   www.datavideo.info 

Datavideo Technologies Co., Ltd. 
10F, 176 Jian-Yi Rd, Chung Ho City, Taipei Hsien, Taiwan 235 
Tel: +886 2 8227 2888  service@datavideo.com.tw www.datavideo.com.tw 

Datavideo Technologies China Co. 
2F-D, 2 Lane 777, West Guangzhong Rd, Zhabei District, Shanghai, China 
Tel: +86 21 5603 6599  service@datavideo.cn  www.datavideo.cn 

Datavideo Technologies (S) PTE Ltd. 
No. 22 Lorong 21A Geylang, #09-02 Prosper Industrial Building, Singapore 388431 
Tel: +65 6749 6866  info@datavideo.sg  www.datavideo.sg 

Datavideo Hong Kong Limited 
G/F., 26 Cross Lane, Wanchai, HK 
Tel: +852 2833 1981  info@datavideohk.com  www.datavideohk.com 
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